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Section 1: Introduction

Section 1: Introduction

This section includes contact information, Quick Start procedure, photos of a
standard SBE 26 SEAGAUGE Wave and Tide Recorder, and shipping
precautions for lithium batteries.

About this Manual

This manual is for use with the SBE 26 SEAGAUGE Wave and Tide Recorder.
It is organized to guide the user from installation through operation, and data
collection and processing. We’ve included detailed specifications, command
descriptions, maintenance and calibration information, and helpful notes
throughout the manual.

Sea-Bird welcomes suggestions for new features and enhancements of our
products and/or documentation. Please e-mail any comments or suggestions to
seabird@seabird.com.

How to Contact Sea-Bird

Sea-Bird Electronics, Inc.
1808 136™ Place Northeast
Bellevue, Washington 98005 USA

Telephone: 425-643-9866 Fax: 425-643-9954
E-mail: seabird@seabird.com Website: http://www.seabird.com

Business hours:

Monday-Friday, 0800 to 1700 Pacific Standard Time
(1600 to 0100 Universal Time)

Except from April to October, when we are on summer time
(1500 to 0000 Universal Time)
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Quick Start

Follow these steps to get a Quick Start using the SBE 26. The manual provides
step-by-step details for performing each task.

Deployment:

1. Run Plan Deployment and Battery and Memory Endurance to determine
sampling parameters (Section 4).

2. Install new batteries.

3. Connect SBE 26 to computer and run SeatermW (Section 5):

A. Ensure all data has been uploaded, and then send IR to make entire

memory available for recording if desired.

B. Set date and time (ST) and wave and tide sampling parameters (SI);
enable conductivity if SBE 4M conductivity sensor is installed (CY).
Check status (DS) and calibration coefficients (DC).

Start logging (GL).

o0

Recovery and Data Processing:

1. Connect SBE 26 to computer and run SeatermW. Quit logging (QL.), and
upload data from SBE 26 memory (Section 5).

2. Run Convert Hex to convert raw data into separate wave and tide files
(Section 6).

3. Run Merge Barometric Pressure to remove barometric pressure from
tide file (Section 7).

4. Run Process Wave Burst Data and Create Reports to calculate and
summarize wave statistics (Section 8).

5. Run Plot Data to display the data (Section 9).
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Unpacking SBE 26

Shown below is a typical SBE 26 shipment.

I/O Cable 9-pin adapter

Pressure Sensor Spare parts kits (2) Jackscrew Kit
Oil refill kit

SBE 26 SEAGAUGE

SBE 26 Manual Software, and Electronic Copies of
Software Manuals and User Manual
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Shipping Precautions — Electrochem Lithium Batteries

Note:

Remaining battery capacity for
used Electrochem lithium
batteries is not known and cannot
be determined without
consumptive testing. We do not
recommend reusing them
unless you can positively
determine how many samples
were recorded with the batteries
since their purchase.

The SBE 26 may be powered with Electrochem Lithium Batteries. Sea-Bird
supplied these batteries as an option for the SBE 26 until February 2004, but
does not supply these batteries anymore because of changes in regulations
governing shipment of lithium batteries. Sea-Bird does sell a lithium battery
pack kit, for building a battery pack using lithium batteries purchased
elsewhere. The following applies only to Lithium batteries, not to the standard
alkaline batteries.

The Law

U. S. domestic transportation of Electrochem lithium batteries is regulated by
the Department of Transportation (DOT) through Title 49 Code of Regulation
(49 CFR), HM-181 part 173.185. Internationally, air transportation is
regulated by the International Air Transport Association (IATA). Pursuant to
49 CFR 173.185, all shipments of hazardous materials must comply with
packaging regulations based on recommendations made by the United Nations.

The shipper is responsible for compliance with the law. Sea-Bird cannot
advise you on this matter; consult the proper authorities.

Shipping
Note that the batteries must not be shipped inside the instrument.
If you will re-ship the SBE 26 by commercial aircraft:

1. Remove the batteries from the SBE 26.
2. Properly package and label the batteries, and fill out the required
Dangerous Goods documentation.

If you will be shipping your SBE 26 to Sea-Bird for servicing or calibration,
DO NOT RETURN THE ELECTROCHEM LITHIUM BATTERIES
TO SEA-BIRD. Remove and store the batteries for future use, or dispose

of properly. If you send the batteries to Sea-Bird, we will not ship them back
to you. We will dispose of the batteries unless you are able to arrange to pick
them up at Sea-Bird.
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Section 2: Description of SBE 26

This section describes the functions and features of the SBE 26, including
specifications, dimensions, power supply, and data I/O protocols.

System Description

The SBE 26 SEAGAUGE Wave and Tide Recorder combines Sea-Bird's
reliable semiconductor-memory electronics with a stable time base, quartz
pressure sensor, precision thermometer, and an optional SBE 4M conductivity
sensor to provide wave and tide recording of unprecedented resolution

and accuracy.

For tide and water level monitoring, the pressure sensor output is continuously
integrated to average out wave action. The user-programmable tide integration
time can be set from 1 minute to 500 hours, on 1-minute intervals. High-
accuracy temperature information is recorded with each tide measurement. As an
option, an SBE 4M conductivity sensor can be installed for recording
conductivity data with each tide measurement. Waves are characterized by burst
sampling, with the number of samples per burst, burst interval, and burst
integration time programmed by the user.

The SBE 26 is self-contained in a rugged non-corroding plastic housing
(600-meter depth rating); optional titanium housing for depths to 7000 meters is
available. After recovery (and without opening the housing), the recorded data is
transferred to a computer via an RS-232C data link for analysis, plotting, and
permanent archiving. The battery compartment contains nine standard alkaline
D-cells and is sealed separately to minimize risk to the electronics.

The standard pressure sensor is a 20 meter (45 psia) Quartzonix, with a
temperature-compensated quartz element. An optional Paroscientific Digiquartz
pressure sensor with a temperature-compensated quartz element is available in
13 ranges, from 1 to 6800 meters (15 to 10,000 psia). Temperature is measured
with an aged, super-stable thermistor embedded in the SBE 26 end cap.

Tide measurements are obtained by continuously counting the pressure
frequency with a 40-bit ripple counter. Each time the SBE 26 wakes up, the
ripple counters are latched into registers and then reset. The wake-up times are
set by a continuously powered, real-time clock with an accuracy of 5 ppm and a
resolution of 2 milliseconds.

Wave burst measurements are made with a period counter, with its time base
generated from a temperature-compensated, precision quartz crystal oscillator.

SBE 26 options include:

e SBE 4M conductivity sensor

e Titanium housing for use to 7000 meters (22,960 feet)

e Digiquartz pressure sensor

o  Wet-pluggable bulkhead connectors in place of Impulse glass-reinforced
epoxy bulkhead connectors

e  Battery pack kit for lithium batteries for longer deployments (lithium
batteries not supplied by Sea-Bird)

e  Mounting fixture
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Notes:

Sea-Bird supplies the current version

of our software when you purchase

an instrument. As software revisions
occur, we post the revised software
on our FTP site. See our website

(www.seabird.com) for the latest

software version number, a

description of the software changes,

and instructions for downloading the
software from the FTP site.

o Help files provide detailed
information on SEASOFT
for Waves.

e Users report difficulty
communicating with the SBE 26
using the SEASOFT for Waves —
DOS terminal program (Term26)
on computers running Windows.

The SBE 26 is supplied with a software package for pre-deployment planning,
communication with the SBE 26 for setup, uploading of data from the SBE 26,
separation of the raw data into separate wave and tide files, removal of
barometric pressure from tide data, statistical analysis, and data plotting.

Two versions of the software are provided:

e SEASOFT for Waves — Modular Windows 95/98/NT/2000/XP program.

e SEASOFT for Waves - DOS — Modular DOS program.

10
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Specifications

Note:

The pressure sensor is mounted on
the titanium connector end cap, with
the pressure conveyed from the
pressure port to the sensor via an oil-
filled tube. The pressure reading is
position sensitive as a result of the ail
pressure head.

Pressure
0 to 1/5/10/ 20/ 60/ 130/ 200/ 270/ 680/ 1300/ 2000/ 4000/
Range 6800 meters (15/23/ 30/ 45/ 100/ 200/ 300/ 400/ 1000/
2000/ 3000/ 6000/ 10000 psia)
Accuracy* 0.01% of full scale (3 mm for 45 psia range)

Repeatability *

0.005% of full scale (1.5 mm for 45 psia range)

Hysteresis *

0.005% of full scale (1.5 mm for 45 psia range)

Calibration 0 psia to full scale pressure

Tide 0.2 mm for 1-minute integration;
Resolution * 0.01 mm for 15-minute integration
Wave 0.4 mm for 0.25-second integration;
Resolution * 0.1 mm for 1-second integration

* Stated values in mm for accuracy, repeatability, hysteresis, and resolution are
for 45 psia (20 m) pressure sensor. Scale for other ranges, multiplying by
(actual sensor range in psia / 45 psia).

Temperature

Range -5to+35°C

Accuracy 0.02 °C

Resolution 0.01 °C

Calibration +1 to +32 °C (measurements outside this range may be at

slightly reduced accuracy due to extrapolation errors)

Conductivity (optional SBE 4M conductivity sensor)

Range 0.0to 7 S/m
+0.0003 S/m/month (typical);

Accuracy +0.001 S/m/month (guaranteed; not applicable in areas of
high biofouling or contamination or if Application Note 2D
procedures are not followed)

Resolution 0.00002 S/m

Calibration 2.6 to 6 S/m plus zero conductivity (air)

11
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Other Specifications

Counter
Time Base

Quartz TCXO + 2 ppm per year aging;
+ 2 ppm per year versus temperature (-5 to 30 °C)

Memory

8M byte CMOS static RAM, battery-backed for minimum of
2-years data retention

Data Storage

Recorded Parameter Bytes/Sample
Tide with temperature 4
Tide with temperature & optional conductivity 8
Wave burst 3

Real-Time
Clock

Watch-crystal type 32,768 Hz; battery-backed for minimum
of 1-year operation, regardless of condition of main battery.
Corrected for drift and aging by comparison to counter
time base. Accuracy 5 ppm, resolution 2 milliseconds.

Current
Requirements

Quiescent current when not logging: 90 microamps
Quiescent current when logging: 1.2 ma
(while integrating pressure in-between tide samples, only counter,
real-time clock, and pressure sensor are on; microprocessor and
digital electronics are off except for a 4.4-second period during each
tide measurement, and duration of each wave burst)
Operating current (for 4.4-second period during each tide
measurement, and duration of each wave burst)

Without conductivity sensor: 65 ma

With conductivity sensor: 75 ma

9 alkaline D-cell batteries: Typical capacity 5 (cold water) to
10 amp-hours (warm water)
Optional lithium batteries (batteries not supplied by

Power Supply Sea-Bird): Typical capacity of 9 D-cells 42 amp-hours;
3 DD-cells 30 amp-hours
Optional External power source: 10 - 20 VDC
Weight In air, standard housing: 6 kg (13 Ibs)
Housing Standard: 600-meter acetal copolymer (plastic) pressure
. case with titanium end cap
Materials

Optional: 7000-meter titanium pressure case and end cap

12
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Dimensions and End Cap Connectors

99cm

l__ (3.9in) __r
. I
\_- Battery end cap

Shown Below Installed in Optional Mounting Fixture

-+——— Acetal copolymer housing
Optional acetal ——=t
copolymer 68.8 cm
mounting fixture (27.1in.)
(drill as required)
76.5cm
(30.11in.)
SBE 4 mount bracket —
SBE 4 conductivity sensor |
(optional - cable not shown)
77.5cm
(30.5in.)
Titanium connector end cap
Nylon pressure port fitting
m—— Pressure bladder cover
e Data 1/O connector
| _ Conductivity —
-
| connector O—)
r | | 4 :
1 Common e —' | Titanium bolt knob
2 RS-232Receive | L \ |
3 RS2RTransmit | (25" o ) L
4 Aux Power Input [ 30 4 T
(optional 10-20 VDC) | A O\
_____ [ g
Optional MCBH C t '___;_1 l =— I
ptional onnectors [ ; 65in.
= B . 1 Common l - \Q_/ ( )
NS 2  Signal | ) " I
'@ [ I ®: 1@ 3  Power |
13 11 1 e 2@ . | 7
0000 o — ] 13.7cm
29 B e | (5.381n.)
Conductivity Data 11O
Connector Connector
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Power Supply

Note:

For battery endurance calculations,
see Section 4: Pre-deployment
Planning — Plan Deployment and
Battery and Memory Endurance.

The main batteries for a standard SBE 26 are nine D-cell alkaline batteries
(Duracell MN 1300, LR20). The SBE 26 can also be powered by lithium
batteries; Sea-Bird can supply a lithium battery pack kit (lithium batteries not
supplied by Sea-Bird). For lithium batteries, see Shipping Precautions —
Electrochem Lithium Batteries in Section 1: Introduction.

The SBE 26 can also be powered from an external 10-20 VDC source. The
internal batteries are diode-OR’d with the external source, so power is drawn
from whichever voltage source is higher.

On-board lithium batteries (non-hazardous units which are unrestricted for
shipping purposes) are provided to back-up the buffer and the real-time clock in
the event of main battery failure, exhaustion, or removal. The main batteries can
be replaced without affecting either the real-time clock or the memory.

Data I/O

The SBE 26 receives setup instructions and outputs diagnostic information or
previously recorded data via a three-wire RS-232 link. The SBE 26 is factory-
configured for 9600 baud, 7 data bits, 1 stop bit, and even parity.

e  The baud rate for general communication (setup and diagnostics) cannot
be changed by the user.

e  The baud rate for uploading data from memory can be user-programmed to
9600, 19200, or 38400 baud.

14
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Section 3: Software Installation and Use

Notes:

e Sea-Bird supplies the current
version of our software when you
purchase an instrument. As
software revisions occur, we post
the revised software on our FTP
site. See our website
(www.seabird.com) for the latest
software version number, a
description of the software
changes, and instructions for
downloading the software from the
FTP site.

e Users report difficulty
communicating with the SBE 26
using the SEASOFT for Waves -
DOS terminal program (Term26)
on computers running Windows.

This section describes the installation and use of the software. The SBE 26 is
supplied with a software package for pre-deployment planning, communication
with the SBE 26 for setup, uploading of data from the SBE 26, separation of the
raw data into separate wave and tide files, removal of barometric pressure from
tide data, statistical analysis, and data plotting. Two versions of the software
are provided:

e SEASOFT for Waves — Modular Windows 95/98/NT/2000/XP program.
e SEASOFT for Waves - DOS — Modular DOS program.
Instructions for installing both the Windows and DOS software are included

below. However, details on using the software are provided only for the
Windows software.

Software Installation

Notes:

e Sea-Bird ships each new and
recalibrated SBE 26 with a .ini file
that reflects the current
calibration. The .ini file is named
with the instrument serial
number, followed with the .ini
extension. For example, for
SBE 26 serial number 2375, we
name the file 2375.ini. You may
rename the file if desired; this will
not affect the results.

¢ Help files provide detailed
information on SEASOFT
for Waves.

SEASOFT for Waves

Recommended minimum system requirements for software:
Pentium 90 CPU, 64 Mbyte RAM, Windows 98 or later.

If not already installed, install SEASOFT for Waves on your computer using
the supplied software CD-ROM:

1. Install the software:
A. In the CD-ROM drive, double click on SeasoftWaves_V* **.exe
(*_** = software version).
B. Follow the dialog box directions to install the software.
The default location for the software is
c:/Program Files/Sea-Bird/SeasoftWaves.

2. Copy the .ini file, which is custom-programmed for your SBE 26, from
the CD-ROM into the desired location on your computer.

15
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Note:

The S2641*.exe file name varies,
depending on the version number.
The * in the file name indicates the
version number. For example, for
SEASOFT for Waves version 4.107,
the .exe file is named s264107.exe.

Note:

Convert Hex (in the Windows
software) replaces the functions
in SEASOFT for Waves — DOS
that require the Term26.cfg file
(the file reflects the current
calibration). Therefore, we only
supply the Term26.cfg file on
special request. Do not rename
the Term26.cfg file.

SEASOFT for Waves - DOS

If not already installed, install SEASOFT for Waves - DOS on your computer
using the supplied software CD-ROM:

1.

Install the software:
A. Inthe CD-ROM drive, double click on the sswaves.dos directory.
B. Copy setup26.bat, s2641*.exe, and the Demo directory to the desired
location on your computer’s hard drive.
C. Double click setup26.bat. to unpack the following files:
Merge26.exe
Plan26.exe
Plot26.exe
Report26.exe
Term26.exe
Wave26.exe
WDisp.exe
SBE $Help.dat
SBE $Msg.dat
SBE $Err.dat
Term.hlp

Copy the Term26.cfg file, which is custom-programmed for your SBE 26,
from the CD-ROM into the same directory as the files in Step 1.

Verify that the root directory on your hard drive contains the file
Config.sys (for example, if you install Seasoft for Waves in

c:/Program Files/sswaves-dos, the Config.sys file location must be
c¢:/Config.sys). Config.sys must have buffers set to at least 20 and files set
to at least 30.

16
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SEASOFT for Waves Use

Start SEASOFT for Waves by double clicking on SeasoftWavesLaunch.exe.

The main screen looks like this:

ol
|Run Help
1. Plan Deplovment. ..
2, Battery and Memory Endurance. ..
3. Seatermia. ..
4, Convert HE=. ..
5. Merge Barometric Pressure. ..
6. Process Wave Bursk Data, ..
7. Create Reports. ..
8. Plot Data. ..
Exit
The Run menu lists each program module:
s Equivalent
Type Module Name Module Description DOS Module
Calculate ratio of pressure amplitude
measured by instrument to pressure Wiisp and
Plan Deployment | amplitude at surface. Predict number of P
Pre-deployment . Plan26
lanning frequency bands calculated, width of each
P . band, and frequency span.
See Section 4 -
Battery and Calculate nominal battery and
Memory memory endurance for user-specified -
Endurance sampling scheme.
Terminal program SeatermW Send commands for status, data acquisition Term26
See Section 5 setup, diagnostics, and data upload.
Data conversion Convert uploaded raw data file into separate
. Convert Hex wave and tide files, with output data in Term26
See Section 6 . . .
engineering units.
. . Merge
Tide data processing Barometric Remove barometric pressure from tide data. Merge26
See Section 7
Pressure
Process Wave Compute wave statistics. Wave26
. Burst Data
Wave data processing - - .
: Output one line of surface wave time series
See Section 8 S
Create Reports | and/or wave burst auto-spectrum statistics Report26
for each processed wave burst.
Plot data from a .tid, .wb, .was, .wts, and/or
Data plottin .wt file; plots can be printed. Plot Data can
plotting Plot Data plot data at any point after raw hex data is Plot26
See Section 9 . .
converted into separate wave and tide files
in Convert Hex.

17
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File Formats

File extensions are used by SEASOFT for Waves to indicate the file type:

Extension

Description

.bmp

Bitmap graphics file created by Plot Data.

.bp

Barometric pressure data, used by Merge Barometric Pressure to
remove barometric pressure from the tide data (.tid) file.

.cap

Data and/or diagnostics captured using SeatermW.

.hex

Raw Hex data uploaded from SBE 26 memory using SeatermW.

.ni

There are three .ini files used in SEASOFT for Waves:

Sea-Bird ships each new and recalibrated SBE 26 with a .ini
file containing the appropriate calibration coefficients -
pressure sensor slope and offset corrections, temperature
sensor calibration coefficients, and optional conductivity
sensor calibration coefficients. The .ini file is named with
the instrument serial number, followed with the .ini
extension. For example, for SBE 26 serial number 2375, we
name the file 2375.ini. You may rename the file if desired;
this will not affect the results. This .ini file is required by
Convert Hex. Each time you save a .ini file, Convert Hex
copies the file to CNVHex.ini, in your c:/Windows
directory. The next time you open Convert Hex, it
automatically opens CNVHex.ini; you can use that file or
select a different file.

SeasoftWaves.ini, in your Windows directory, contains the
location and file name of the last saved Program Setup (.psa)
file and options settings for each module with a .psa file
(Merge Barometric Pressure, Process Wave Bursts,

Create Reports, and Plot Data).

SeatermW.ini, in your Windows directory, contains the last
instrument type (SBE 26, 26plus, or 53), COM port (used
for communicating with the SBE 26) and upload baud rate
used in SeatermW.

Jpg

JPEG graphics file created by Plot Data.

.psa

Program Setup file, used by Merge Barometric Pressure, Process
Wave Bursts, Create Reports, and Plot Data to store setup
information (input and output file names and locations, and
processing instructions).

.r26

File containing one line of surface wave time series and/or wave
burst auto-spectrum statistics for each processed wave burst,
created by Create Reports.

.rpt

Summary report, created by Process Wave Burst Data.

tid

Tide measurements in engineering units, created from raw .hex
file by Convert Hex. Also, file format for tide data that has had
barometric pressure removed by Merge Barometric Pressure.

.was

Statistics and results from auto-spectrum analysis, created by
Process Wave Burst Data.

.wb

Wave measurements in engineering units, created from raw .hex
file by Convert Hex.

wmf

Windows metafile graphics file created by Plot Data.

WSS

Fast Fourier Transform coefficients, created by Process Wave
Burst Data if selected.

wt

Surface wave time series, created by Process Wave Burst Data
if selected.

.wits

Statistics from surface wave zero crossing analysis, created by
Process Wave Burst Data.

See Appendix I11: Data Formats for details on the format of each file.
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Section 4: Pre-Deployment Planning —
Plan Deployment and Battery and Memory Endurance

This section covers:

e Planning the required wave burst parameters and placement of the
SBE 26, using the Plan Deployment module in SEASOFT for Waves.

e Calculating battery and memory endurance for the desired sampling
scheme, using the Battery and Memory Endurance module in
SEASOFT for Waves.

Plan Deployment

Plan Deployment solves the wave dispersion relation to calculate and plot the

Note: _ pressure attenuation ratio:
See Appendix VI: Wave Theory

and Statistics for a detailed
discussion of the theory and
equations for wave calculations.

Pressure attenuation ratio =
pressure amplitude measured by SBE 26 / pressure amplitude at surface

given:
water depth (meters)
height of pressure sensor above bottom (meters)
wave period (seconds)

Pressure attenuation with depth is a strong function of the wave period; short
period waves are attenuated much faster with depth than longer period waves.
This implies that for a pressure sensor deployed at a fixed depth z, there is a high
frequency cut-off fmax for which waves with f> fmax are not measurable.
Above the high frequency cut-off, any noise in the subsurface pressure record is
mapped by the transfer function into unrealistic surface wave height values.

The default high-frequency cutoff (fmax) for processing wave data in Process
Wave Burst Data is the frequency where the ratio of pressure measured by the
SBE 26 to pressure at the surface is less than (0.0025 / wave sample interval).
Frequencies greater than fmax are typically not processed by Process Wave

Burst Data.
# of wave
samples per burst Plan Deployment also predicts these surface wave analysis parameters:
e number of frequency bands calculated
| | | | | | | | | | | . ;vidth of each fre;lluency band (Hz)
[ ]
NCE requency span (Hz)

given:
water depth (meters)
) height of pressure sensor above bottom (meters)
in burst) wave sample interval (time between successive wave pressure measurements)
points per wave burst (multiple of 4; for example, 4, 8, 16, etc.)
number of spectral estimates for each frequency band

wave sample duration
(length of each sample

Note: The maximum frequency in the frequency span is the lesser of:
If planning to calculate wave e 0.5 /sample interval (called the Nyquist frequency), or
statistics, Sea-Bird recommends the e frequency (fimax described above) where ratio of pressure measured by

following for meaningful, valid results: . .
« Samples per burst > 512, and SBE 26 to pressure at surface is less than (0.0025 / sample interval)

e Samples per burst = power of 2 (for

example, 512, 1024, etc.) Appendix VI: Wave Theory and Statistics provides detailed discussion on

band averaging.
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In SEASOFT for Waves’ Run menu, select Plan Deployment. The dialog box

looks like this:
Plan Deployment - 10| x|
Water Depth [meters] | 10 Calculate Spectral
Enter values and then click : PQEITIEUETS
Calculate Spectral Parameters to Inetrurment Height Above Bottom [meters] I 1
calculate bands, band Wldth, and > Spectral E ztimatesz per Band | 10 HEll:l
frequency span, and calculate )
and plot pressure attenuation. Wave Sample Duration [seconds] | 0.25
Note that wave sample duration I— E it
and wave samples per burst Wwave Samples per Burst 1024
are programmed into SBE 26 — 9 Bands Calculated
with SI. Band Width [Hz): 0.0391 Cancel
Frequency Span [Hz): 0.0215 - 0.3340
Pressure Attenuation [p(inst) / p(surf)] VS Wave Period
1.0
0.9 E F.«-lﬂ'
08 = /,p"e"".‘“
= =
S 07E i
Pressure attenuation is wave 2 E j
pressure amplitude measured by &@ D6 .’,’
instrument divided by wave Tos =
pressure amplitude at surface. +—» = /
So4F ¢
n E
®0.3-E 4
g =
£ F 7
0.2 7
0.1
oo :Illl¥¥“lll per b b berr b b b b

0. 2.5 5.0 T.4a 10.0 12.5 15.0 17.58 20.0 225 25.0
Wave Period (seconds)

Example:

Water depth is 10 meters. You are interested in measuring waves with
frequencies up to 0.36 Hz (period =1/ 0.36 = 2.8 seconds). You plan to
sample waves 4 times per second (wave sample interval = 0.25 seconds)
with 1024 samples/wave burst, and to process data with

10 spectral estimates/band. Can you place the SBE 26 at 1 meter

above the bottom and accomplish your goals?

Running Plan Deployment with the above parameters (see dialog box
above), the Frequency Span is 0.0215 to 0.3340 Hz. Since 0.3340 < 0.36,
you cannot accomplish your goals.

Iterating on a solution by changing the instrument height in Plan Deployment,
you find that placing the SBE 26 at 2.5 meters above bottom will allow you to
measure the desired frequencies. Alternatively, you could consider modifying
other sampling parameters while maintaining the instrument height.
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Battery and Memory Endurance

Note:

See Specifications in Section 2:
Description of SBE 26 for power and
memory specifications.

Power and memory endurance calculations for the SBE 26 are complex, and
are dependent on the sampling scheme. Use Battery and Memory Endurance to
calculate the endurance for a user-specified sampling scheme.

In SEASOFT for Waves’ Run menu, select Battery and Memory Endurance.
Click on the SBE 26 tab in the dialog box. The dialog box looks like this:

&% Battery and Memory Endurance

File Help

SBE 26plus-Quartz | SBE 2Bplus-Strain  SBE 26 | SBE 53BFR |

Enter tide measurement interval, number of
tide measurements between each wave
burst, wave samples/burst, wave sample
duration, and whether conductivity is also
measured. Sampling setup is programmed
into SBE 26 with SI; conductivity sampling
is programmed into SBE 26 with CYor CN.

Tide meazurement interval [minutes] =

Measure waves every M tide samples, M =

YWave samples per burst =

YW ave sample duration [geconds] =

=10i x|

S
E—

[ Conductivity

YWave burst duration [seconds) =128 <

(Battery capacity / daily power consumption)
e Based on input sampling scheme and
nominal 8 amp-hour capacity

Wave samples/burst * Wave sample duration

Click Calculate to calculate battery
and memory endurance.

= Mominal alkaline battery endurance [dayz] = 174.9
8 MEB Memory endurance [days] = 12725 €——

Based on input sampling scheme
and memory storage requirements.

—* Calculate I Help Exit
J Tide interval J Tide interval J Tide interval J Tide interval J
| | # of wave | | |
samples/burst Notes:

| ]
| W

Wave sample
| |

in burst)

l N

duration (length
of each sample
I 3

samples (N

I
Measure waves every N tide
=2 as shown)
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e This drawing is schematic only, intended
to define the sampling scheme
terminology. See Appendix II:

Sample Timing for timing details.

e See Command Descriptions in Section 5:
SBE 26 Setup, Installation, and Data
Upload — SeatermW for programming
desired sampling scheme in SBE 26.
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Discussions follow of the data and equations used in Battery and Memory

Note: Endurance; use this information to perform your own calculations if desired.
See Specifications in Section 2:
Description of SBE 26 for power Battery Endurance

requirements and battery ratings.

e Quiescent power consumption when logging (amp-hours per day)
Only counter, real-time clock, and pressure sensor are on continuously
while logging.

1.2 mA * 86400 seconds/day * 1 hr/3600 second * 1 amp /1000 ma
= (0.0288 amp-hours/day

e Tide measurement
On time for microprocessor and digital electronics during each
tide measurement = 4.4 seconds.

Power consumption (amp-hours) during tide measurement on time:

Without conductivity sensor (65 ma operating current)
4.4 seconds * 65 ma * 1 hr/3600 second * 1 amp/1000 ma
=8.0 x 10~ amp-hours

With conductivity sensor (75 ma operating current)
4.4 seconds * 75 ma * 1 hr/3600 second * 1 amp/1000 ma
=9.2 x 10 amp-hours

e \Wave measurement

Wave burst duration =
[number of wave measurements * wave integration time (seconds)] + 1

Power consumption (amp-hours) during each wave burst =
65 ma * 1 hr/3600 second * 1 amp/1000 ma
= 1.8 x 10 ® amp-hours / second of wave burst

e Total power consumption (amp-hours)

Without conductivity sensor

(total number of days * 0.0288) +

(total number of tide measurements * 8.0 x 10~) +

(total number of wave burst measurements * burst duration * 1.8 x 10~°)

With conductivity sensor

(total number of days * 0.0288) +

(total number of tide measurements * 9.2 x 10 ) +

(total number of wave burst measurements * burst duration * 1.8 x 10~)

Example: SBE 26 without conductivity sensor; with standard alkaline batteries.

Measure tides every 15 minutes (4/hour * 24 hours = 96 measurements/day).

Measure waves after every 24 tide samples (96 / 24 = 4 wave bursts/day).

Take 512 wave measurements per burst, at 0.25-second integration time per measurement.

Wave burst duration / day = 4 [(512 * 0.25) + 1] = 516 seconds.

Assume 8 amp-hours of battery capacity.

(Note: This is same sampling scheme as shown in Battery and Memory Endurance dialog box above.)

Power consumption = [(0.0288) + (96 * 8.0 x 10 '5) + (516 * 1.8 x 10 N )] * Number of Days

Power consumption = 0.045768 * Number of Days

Number of days of battery capacity = 8 amp-hours / 0.045768 = 174.8 days

As a check, compare with the output of Battery and Memory Endurance on the SBE 26 tab; the program shows
approximately the same results.
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Memory Endurance

Note:

In response to the status (DS) or The SBE 26 comes standard with an 8 MB memory. Memory used for storing
sample interval (SI) command, the logged data is:

SBE 26 calculates memory endurance

for the given sampling scheme, taking 4% %

into account the number of samples Bytes/day =4* (N+C+W[(0.75*M)+4])

already in memory. Battery and

Memory Endurance calculates the where _

total memory endurance for a N = number of tide samples/day

sampling scheme. C =N = number of conductivity samples/day (if conductivity enabled)

W = number of wave bursts/day

M = number of wave measurements/burst

Example: SBE 26 without conductivity sensor.

Measure tides every 15 minutes (4/hour * 24 hours = 96 measurements/day).

Measure waves after every 24 tide samples (96 / 24 = 4 wave bursts/day).

Take 512 wave measurements per burst.

(Note: This is same sampling scheme as shown in Battery and Memory Endurance dialog box above, and in power
endurance calculation examples.)

N =96, C = 0 (no conductivity sensor), W =4, M =512

Bytes/day =4 * (96+0+4 [ (0.75* 512 )+ 4 ]) = 6592 bytes/day
Memory capacity = 8 MB * 1024 * 1024 = 8,388,608 bytes

Memory endurance = 8,388,608 / 6592 = 1272.5 days

As a check, compare with the output of Battery and Memory Endurance; the programs shows approximately the same
results. Note that for this example, the SBE 26 memory capacity far exceeds the power capacity.
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Section 5: SBE 26 Setup, Installation, and
Data Upload - Seatermw

Note:

If desired, use the Term26 module in
SEASOFT for Waves — DOS in place
of SeatermW.

This section covers:

Programming the SBE 26 for deployment using SeatermW
Command descriptions

Installing and deploying the SBE 26

Recovery and uploading data from memory using SeatermW

Programming for Deployment - SeatermW

1.

2.

Connect the SBE 26 to the computer using the 4-pin data I/O cable:

A. By hand, unscrew the locking sleeve from the SBE 26’s I/O
connector. If you must use a wrench or pliers, be careful not to loosen
the I/0 connector instead of the locking sleeve.

B. Remove the dummy plug from the SBE 26’s I/O connector by pulling
the plug firmly away from the connector.

C. Standard Connector - Install the Sea-Bird I/O cable connector,
aligning the raised bump on the side of the connector with the large
pin (pin 1 - ground) on the SBE 26. OR
MCBH Connector — Install the cable, aligning the pins.

D. Connect the I/O cable connector to your computer’s serial port.

In SEASOFT for Waves Run menu, select SeatermW.
The main screen looks like this:

#2 Seaterm¥ Yersion 1.03 =10l =l
File Conmmect Configure.., Stakus  Coefficients  Upload... Capture.T Stop  Diagnoskic..,  Help
Command/Data Echo Area Menus
Status bar Computer Comm
Status — Ready, port, general
Uploading, bar f Instrument communication
Finished Prolgreds_s ?jr or and baud rate, data bits,
Upload, etc. uploading data firmware stop bits, and parity
¢ ¢ version ¢
v =l
[ready [ | |comt, se00, 7, 1, E P

Note:

Once the system is configured and
connected (Steps 3 and 4 below), to
update the Status bar, click Status.
SeatermW sends the status
command (DS), which displays in
the Command/Data Echo Area, and
updates the Status bar.

e  Menus — Contains tasks and frequently executed instrument
commands.

e Command/Data Echo Area — Echoes a command executed using a
Menu, as well as the SBE 26’s response. Additionally, a command
can be manually typed in this area, from the available commands for
the SBE 26. The SBE 26 must be awake for it to respond to a
command (use Connect to wake up the SBE 26).

e  Status bar — Provides status information.
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Note:
You must be connected to the

instrument (Connect) when using
Status, Coefficients, Upload, Stop,

or Diagnostic.

Select SBE 26.

Following is a description of the menus:

o Equivalent
Menu Description Command*
File Exit SeatermW. -
Re-establish communications with
SBE 26. Computer responds with
Connect S> prompt. SBE 26 goes to sleep after (press Enter key )
2 minutes without communication from
computer have elapsed.
Conficure Establish communication parameters )
£ (instrument, Comm port, upload baud rate).
Status Display SBE 26 setup and status (logging, DS
samples in memory, etc.).
Display pressure sensor and temperature sensor
Coefficients |calibration coefficients that are hard coded in DC
SBE 26 EPROM.
Upload data stored in memory, in format our Upload with DDbe,
. DEb,e, or DAb,e (use
data processing modules can use. Uploaded . .
Upload . . Upload if you will be
data has .hex extension. Before using Upload, processing data with
send QL to stop logging. SEASOFT for Waves)
Capture SBE 26 responses on screen to file;
Capture may be useful for diagnostics. File has .cap i
P extension. Click Capture again to turn off
capture. Capture status displays in Status bar.
Interrupt and end current activity, such as
uploading data or running a diagnostic test
Stop (such as FR or VR). (press Etsl;l:g/ several
Note: This does not stop logging — use QL to
stop logging.
Perform diagnostic tests on SBE 26. Diagnostic
N DS; DC;
. . tests accessed in this manner are non-
Diagnostic . . DDO0,10;
destructive — they do not write over any ER
existing settings.

*See Command Descriptions below.

3. Click Configure. The dialog box looks like this:

SeatermW Configuration

Computer

Comm port for
communication
with SBE 26.

{* SBE 26
" SEE 26plus

x|

-

Baud Rate Upload Baud Rate

o Port
[

52 8 EEEEE [ EE S

Note:
The SBE 26 communicates at
9600 baud, 7 data bits, 1 stop

and even parity, as documented on
the instrument Configuration Sheet.

bit,

N

Upload baud rate
for communication
between computer
and SBE 26.

Baud for general
communication is
always 9600.

Help | Cancel |

Verify/modify the parameters in the Configuration dialog box: Click OK.

4. Click Connect. The display looks like this:
SEAGAUGE POWER ON

S>

This shows that correct communications between the computer and SBE 26

has been established. If the system does not respond with the S> prompt:

e Click Connect again.

e  Verify the instrument and Comm port were entered correctly in the
Configure dialog box.

e  Check cabling between the computer and SBE 26.
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5. Display SBE 26 status information by clicking Status; SeatermW sends

Note: DS. The display looks like this:

The SBE 26 automatically enters SBE 26 SEAGAUGE V4.1d SN335, 06/06/02 08:37:54.328
quiescent (sleep) state after pressure sensor: serial number 36285, range = 45 psi
2 minutes without receiving a clk = 32767.843 iop = 63 wvmain = 13.1 wvlith = 5.9
command. This timeout algorithm last sample: p = 14.6734 t = 2.227

conserves battery energy if the
user does not send QS to put the
SBE 26 to sleep. If the system
does not appear to respond,

tide measurement interval = 15 min
measure waves every 24 tide samples
128 wave samples/burst at 4.00 scans/second

click Connect to reestablish tide samples/day = 96.000
communications. wave bursts/day = 4.000
memory endurance = 4227.482 days
recorded tide measurements = 0
recorded wave bursts = 0

conductivity = NO
logdata = NO

6. Send the desired commands to set up the SBE 26 (see Command
Descriptions below). Verify the setup by clicking Status again.

7. Test the setup by typing GL and pressing the Enter key to begin logging.

The SBE 26 responds:
Start logging Y/N?
Type y and press the Enter key.

The SBE 26 responds:
Are you sure “Y/N? (” indicates the Ctrl key)
Hold down the Ctrl key and type Y, and press the Enter key.

The SBE 26 displays the sample interval setup, and then asks:
Set up ok Y/N?
Type y and press the Enter key.

The SBE 26 responds:
Start data logging

The first two times the SBE 26 begins a tide measurement, the display shows:

Note: SEAGAUGE POWER ON
See Appendix II: Sample Timing for
a detailed description of when tide For the third and subsequent tide measurements, the display looks like this:
and wave measurements are made SEAGAUGE POWER ON
and stored in memory. Tides: 06/07/02 09:27:02.370
Psia=14.7705, ptemp=20.92, tvolt=1.268, cfregq=2699.342
where:

e time = end of tide interval measurement

psia = calculated and stored pressure

ptemp = calculated pressure temperature (not stored)
tvolt = stored temperature voltage

cfreq = conductivity sensor frequency (shown only if conductivity was
enabled with CY)

When a wave burst measurement is made, the display looks like this:
aadadadadad

where:

e One a always displays at the start.

e  Number of d’s = (wave samples/burst + 1). For this example, the
number of wave samples/burst is 4, so 5 d’s display.

e Eachd is preceded by (n — 1) a’s, where n = number of 0.25-second
periods to integrate waves. For this example, n =2 (two 0.25-second
periods, corresponding to a wave sampling rate of 1 scan/0.5 seconds,
or 2 scans/second).

26



Section 5: SBE 26 Setup, Installation, and Data Upload - SeatermW

8. End the test by typing QL and pressing the Enter key to stop logging.

The SBE 26 responds:
Quit logging Y/N?
Type Yy and press the Enter key.

The SBE 26 responds:

Are you sure "Y/N? (" indicates the Ctrl key)
Hold down the Ctrl key and type Yy, and press the Enter key. The SBE 26
stops logging.

9. (ifready for deployment) Type GL and press the Enter key to begin
logging again, overwriting any data in memory.

OR

(if not ready for deployment) Type QS and press the Enter key to
command the SBE 26 to go to sleep (quiescent state).
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Command Descriptions

This section describes commands and provides sample outputs.
See Appendix I: Command Summary for a summarized command list.

When entering commands:

Input commands in upper or lower case letters and register commands by
pressing the Enter key.

The SBE 26 sends # if an invalid command is entered.

If the system does not return an S> prompt after executing a command,
press the Enter key to get the S> prompt.

If a new command is not received within 2 minutes after completion of a
command, the SBE 26 returns to the quiescent (sleep) state and the
display indicates time out.

If in quiescent state, re-establish communications by clicking Connect or
pressing the Enter key to get an S> prompt.

Commands followed by * alter SBE 26 memory and prompt the user twice
before executing (* is not part of the command). To execute the command,
type Yy and press the Enter key in response to message Y/N. Then hold
down the Ctrl key and type Yy, and press the Enter key in response to

are you sure *Y/N. Any other responses abort the command.

The SBE 26 responds only to DS, QS, and QL while logging, and does
not respond at all while making a wave burst measurement. If you wake
up the SBE 26 while it is logging (for example, to send DS to check on
logging progress), it does not interrupt logging. However, the integrated
pressure frequency is incorrect for the interval when the SBE 26 woke up.

Use Upload to upload data that will be processed by SEASOFT for
Waves. Manually entering a data upload command does not produce
data with the required header information for processing by
SEASOFT for Waves.

If the SBE 26 is uploading data and you want to stop it, press the
Esc key or click Stop. Press the Enter key to get the S> prompt.

Entries made with the commands are permanently stored in the SBE 26 and
remain in effect until you change them.

The only exceptions occur if the electronics are removed from the housing
and disconnected from the battery Molex connector (see Appendix IV:
Electronics Disassembly/Reassembly), or the SBE 26’s reset switch is
used (see Section 11: Troubleshooting). Upon reassembly or resetting,
initialize RAM (IR), reset the date and time (ST), and re-enter all the
setup parameters.
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Status Commands

Notes:

o If the battery voltage is below the
battery cut-off voltage (7.0 volts), the
following displays in response to DS:
WARNING: LOW BATTERY
VOLTAGE! ! Replace the
batteries before continuing.

¢ You can wake up the SBE 26 and
display status (press Enter key to
get s>, then click Status) without
interrupting logging. However, the
integrated pressure frequency is
incorrect for the interval when the
SBE 26 woke up.

Note:

Memory endurance in the DS

response is based on remaining space

in memory, taking into account the

number of tide measurements and

wave bursts in memory and the setup

(tide measurement interval, wave

samples, etc).

To determine total memory endurance

for a sampling scheme:

¢ Run Battery and Memory
Endurance, or

e Verify all logged data has been
uploaded from memory; delete all
logged data in memory with IR; and
send DS again.

For information on battery endurance,
see Battery and Memory Endurance in
Section 4: Pre-Deployment Planning —
Plan Deployment and Battery and
Memory Endurance for calculating
power consumption for your intended
sampling scheme.

DS

Display operating status and
setup parameters.

Equivalent to Status menu.

List below includes, where applicable,
command used to modify parameter.

e Firmware version, serial number, date
and time [ST]

e  Pressure sensor serial number and full
scale range

e Real-time clock frequency, voltages
and currents (main operating current,
main and back-up lithium battery
voltages)

e  Wait interval after each line of data
[LWX] — line only appears if not 0

e Last measured pressure (psia) and
temperature (°C)

e Interval between tide samples [SI]

e Interval between wave bursts [SI]

e  Number of wave measurements/burst
[SI]

e Calculated number of tide
samples/day [based on Sl]

e Calculated number of wave bursts/day
[based on Sl]

e Calculated memory endurance for
sampling scheme [based on Sl and
number of measurements in memory]|

e  Number of tide measurements
in memory

e  Number of wave bursts in memory

e  Enabling of conductivity sensor [CX]

e Logging status (logdata=no or yes)

Example: (user input in bold).
S>DS

SBE 26 SEAGAUGE V4.1d SN335, 06/06/02 08:37:54.328

pressure sensor: serial number 36285, range = 45 psi
clk = 32767.843 iop = 63 wvmain = 13.1 wvlith = 5.9
lwait = 1000 msec

last sample: p = 14.6734 t = 2.227

tide measurement interval = 15 min

measure waves every 24 tide samples

128 wave samples/burst at 4.00 scans/second
tide samples/day = 96.000

wave bursts/day = 4.000

memory endurance = 4227.482 days
recorded tide measurements = 0
recorded wave bursts = 0

conductivity = NO
logdata = NO

29




Section 5:

SBE 26 Setup, Installation, and Data Upload - SeatermW

Notes:

e These calibration coefficients
should match the Calibration
Sheets supplied with the SBE 26.

e Some temperature sensor
Calibration Sheets list g and x
instead of Al and XI. Verify that
g=Aland x = XL

e These calibration coefficients are
hard coded into the SBE 26
EPROM, and cannot be changed
by command. Other calibration
parameters are entered in
Convert Hex’s Coefficient
Configuration dialog box when
converting the raw uploaded
data to engineering units; see
Section 6: Conversion into Tide
and Wave Files — Convert Hex.

e For discussion of how calibration
coefficients are generated,
see Sensor Calibration in
Section 10: Routine Maintenance
and Calibration.

Status Commands (continued)

DC Display pressure sensor and temperature
sensor coefficients that are hard coded into
SBE 26 EPROM.

Example: SBE 26 with Paroscientific Digiquartz sensor (user input in bold).
s>DC

Paroscientific Digiquartz calibration coefficients:
U0 5.842227

Yl = -3.932.789

Y2 = -11618.080

Y3 = 0.000

Cl = 157.03740

C2 = 20.163780

C3 = -148.10980

D1 = 0.0507923

D2 = 0.000

Tl = 25.08749

T2 = 0.4489404

T3 = 17.33406

T4 = 0.000
T5 = 0.000
M = 9532.5
B = 4766.3

Temperature coefficients:
Z = -49043.5

RH = 47000.0

AT 271800.0

XI -8.745

Setup Commands

IR * Initialize memory, which destroys all
logged data in SBE 26 memory. SBE 26
requires verification before it proceeds.
All data bits are set to 0; sample number
and data pointers are set to 0. Allow
several minutes to initialize memory.

Send IR after uploading all data. Use of
IR is optional, as SBE 26 writes over
previously recorded information when
GL is sent to begin logging. However,
knowledge of initial memory contents
(i.e., all zeroes) can be a useful cross-
check when data is retrieved.

Example (user input in bold):

S>IR

Initialize ram Y/N? Yy

Are you sure “Y/N? "y (Note: " indicates Ctrl key. Hold down Ctrl key and
type Y, and press Enter key.)

Writing ram O

Writing ram 255

ST Set real-time clock date and time.

Example (user input in bold): Set current date and time to 05 October 2002 12:00:00.
S>ST

date (MMDDYY)=100502

time (HHMMSS)=120000
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Setup Commands (continued)

Sl

J Tide interval J Tide interval J

Tide interval

Set sampling intervals and parameters.
SBE 26 displays present value and asks for

] Tide interval | new value for each parameter. Type in

| | # of wave |
samples/burst

| |

NG

| | Wave sample |
duration (length

| | of each sample

in burst)
| N, ]

desired value and press Enter key. To
accept present value without change, press
Enter key. Program prompts as follows:

<

Note:
This drawing is schematic only, intended to
define the sampling scheme terminology. See
Appendix Il: Sample Timing for detailed
description of when tide and wave
measurements are made and stored in memory.

Measure Wavés every N tide
samples (N=2 as shown)

Note:

Time required for each wave burst must be
less than (tide interval - 30 seconds). If the
user setup does not meet this requirement,
the SBE 26 reduces the number of
measurements in the wave burst to meet
the requirement.

Note:

Memory endurance is based on remaining

space in memory, taking into account the

number of tide measurements and wave

bursts in memory and the setup (tide

measurement interval, wave samples, etc).

To determine total memory endurance for a

sampling scheme:

1. Verify all logged data has been uploaded
from memory.

2. Delete all logged data in memory with IR.

3. Send Sl or DS.

For battery endurance, see Battery and
Memory Endurance in Section 4: Pre-
Deployment Planning — Plan Deployment and
Battery and Memory Endurance.

¥ I

tide interval (integer minutes) = 15 minutes, new value =

Time for each tide measurement.

SBE 26 integrates data over this entire
period, counting frequency signal
continuously and computing an average
pressure for the interval.

wave burst after every N tide measurements: N = 4, new value =

Wave burst is sampled every
(N * tide interval minutes).
Maximum is 32767.

wave samples/burst (integer multiple of 4) =128, new value =

Number of wave measurements/burst.

If entered number is not multiple of 4,
SBE 26 rounds down to make it multiple
of 4. To calculate wave statistics on
uploaded data, Sea-Bird recommends
following for meaningful, valid results:
-- waves samples/burst > 512, and

-- wave samples/burst = power of 2 (512,
1024, etc.).

number of 0.25 second periods to integrate waves (1-128) = 1,
new value =
SBE 26 samples at maximum rate of 4 Hz
(0.25 seconds / wave burst measurement).
This parameter reduces wave burst
sampling rate and increases integration
time per measurement (for example, one
0.25-second period to integrate
corresponds to wave sample duration of
0.25 seconds; ten 0.25-second periods to
integrate corresponds to wave sample
duration of 2.5 seconds).

SBE 26 then displays a summary of sampling parameters as well as
the calculated number of samples per day and memory endurance for
the input sampling scheme (shown in example below). Note that this
information is also included in DS response. After displaying
summary, SBE 26 asks:

Wave and tide intervals ok Y/N ? =
Yy to save parameters and return to S>
prompt, or n to start over at first prompt.
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Setup Commands (continued)

Example (user input in bold):

Set up SBE 26 to take a tide measurement every 15 minutes (tide interval = 15),
measure waves after every 24 tide samples (wave burst after every N tide measurements
= 24), and take 512 wave samples per wave burst (wave samples/burst =512) at 1 Hz
(number of 0.25 second periods to integrate waves = 4).

s>Sl
SBE 26 responds with prompts (described above) for you to enter sampling parameters.
Press Enter key to accept current value, or type in new value and press Enter key.

When finished, a summary of parameters displays. For this example:
tide measurement interval = 15.0 min
measure waves every 24 tide samples

512 wave samples/burst at 1.00 scans/second

tide samples/day = 96.000
wave bursts/day = 4.000

memory endurance = 1272.544 days
recorded tide measurements = 0
recorded wave bursts = 0

Then, SBE 26 prompts:
Wave and tide intervals ok Y/N ? =Y

Cx Xx=Y: Enable conductivity logging
(if SBE 26 includes optional SBE 4M
conductivity sensor).

X=N: Disable conductivity logging.

LWx X= wait interval (milliseconds) after each
line of data. Normally set to 0; increase for
very old (slow) computers.

Range 0 - 65535.

QS Quit session and place SBE 26 in
quiescent (sleep) state. Main power is
turned off. Memory retention is
not affected.
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Logging Commands

Note:

You can wake up the SBE 26 and
display status (press the Enter key
to get the s>, then click Status)
without interrupting logging.
However, the integrated pressure
frequency is incorrect for the
interval when the SBE 26 woke up.

GL * Start logging, which overwrites all
logged data in SBE 26 memory.
Therefore, SBE 26 requires verification
before it proceeds. SBE 26 displays
sample intervals and then requires
verification again that setup is OK before
proceeding. When logging starts, first
sample number is set to 0, so any
previously recorded data is written over,
regardless of whether memory has been
initialized (IR).

QL ~* Quit logging. SBE 26 requires verification
before it proceeds.

S>GL

key.)

S>QL

Example: Start and stop logging (user input in bold).

Start logging Y/N? y
Are you sure "“Y/N? ~y (Note: " indicates Ctrl key. Hold down Ctrl key and type y, and press Enter

(SBE 26 displays sample interval setup, and then asks:)

set up ok Y/N? VY

start data logging

(See Programming for Deployment - SeatermW for a description of screen displays while logging.)

(to stop logging, press Enter key several times to get S> prompt)

Quit logging Y/N? Yy
Are you sure “Y/N? 2y (Note: ~ indicates Ctrl key. Hold down Ctrl key and type Yy, and press Enter key)

Data Upload Commands

Notes:

e Use Upload to upload datato a
.hex file that will be processed
by SEASOFT for Waves.
Manually entering DD, DE, or DA
does not produce data with the
required header information for
processing by SEASOFT for
Waves. These commands are
included here for reference for
users who are writing their own
software.

e To save data to a file, click
Capture before entering DD, DE,
or DA.

e The SBE 26 pauses for 1 second
after receipt of DE or DA to
allow the receiving software to
change the baud rate. The baud
automatically changes back
to 9600 (baud rate for general
communication) after
data uploads.

Stop logging before uploading data.

DDb,e Upload raw data from memory in
Hexadecimal from sample b to e at
9600 baud. If only b is entered, data for
sample b is displayed. If b and e are
omitted, all data displays.

DEb,e Upload raw data from memory in
Hexadecimal from sample b to e at
19200 baud. If only b is entered, data for
sample b is displayed. If b and e are
omitted, all data displays.

DAb,e Upload raw data from memory in
Hexadecimal from sample b to e at
38400 baud. If only b is entered, data for
sample b is displayed. If b and e are
omitted, all data displays.

33




Section 5: SBE 26 Setup, Installation, and Data Upload - SeatermW

Diagnostic Commands

™ * Memory test, which destroys all data in
SBE 26 memory. Therefore, SBE 26
requires verification before proceeding.
A pattern is written into all locations of
each RAM. Data in RAM is then
compared to pattern.

TE * Extended memory test, which destroys all
data in SBE 26 memory. Therefore,
SBE 26 requires verification before
proceeding. Same as TM test, but
10 passes are performed, with pattern
incremented by 1 for each pass.

Example: Perform extended memory test (user input in bold).

s>te

Extended memory test Y/N? Yy

Are you sure “Y/N? "y (Note: " indicates Ctrl key. Hold down Ctrl key
and type Y, and press Enter key.)

Pass 1

Ram 0, OK

Ram 255, OK
(repeats entire sequence for passes 2 through 10)

At conclusion of test or when Esc is received, SBE 26 displays:
Ram test passed with no errors

FR Measure and display frequencies:

Column Output

1 pf = pressure frequency

) tf = pressure temperature
compensation frequency

cf = conductivity sensor
3 frequency (displays only if
conductivity enabled with CY)

SBE 26 runs continuously during test,
drawing current. Press Esc key or Stop to

stop test.
VR Measure and display voltages read by
A/D converter:
Column Output

1 Main battery voltage / 5.0161

Lithium battery voltage / 3.873

2

3 Raw thermistor voltage
4 Raw voltage from large
reference resistor

Raw voltage from small

5 .
reference resistor

SBE 26 runs continuously during test,
drawing current. Press Esc key or Stop to
stop test.
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Installing and Deploying SBE 26

1. Install a dummy plug on the data I/O connector on the SBE 26 end cap:

CAUTION: A. Lightly lubricate the inside of the dummy plug with silicone grease
Do not use WD-40 or other (DC-4 or equivalent).

petroleum-based B. Standard Connector - Install the plug, aligning the raised bump on
lubricants, as they will the side of the plug with the large pin (pin 1 — ground) on the SBE 26.
damage the connectors. Remove any trapped air by burping or gently squeezing the plug near

the top and moving your fingers toward the end cap. OR
MCBH Connector — Install the plug, aligning the pins.

C. Place the locking sleeve over the plug. Tighten the locking sleeve
finger tight only. Do not overtighten the locking sleeve and do not
use a wrench or pliers.

2. Ifnot using the SBE 4M conductivity sensor, install a dummy plug and
locking sleeve on the SBE 26 3-pin bulkhead connector.
Use the technique described in Step 1 for lubricating and burping a
standard connector.

Note: 3. (Optional) Install the SBE 4M conductivity sensor:

Acquisition of conductivity data A. Mount the SBE 4M to the SBE 26 with the supplied mounting

must be enabled by sending CY in bracket, positioning the SBE 4M connector towards the conductivity
SeatermW when programming the connector on the SBE 26.

SBE 26 for deployment. B. Connect the SBE 4M to the SBE 26 with the supplied cable, using the

technique described in Step 1 for lubricating and burping, and then
installing the locking sleeve.

C. Remove the Tygon tubing that was looped end-to-end around the

Mooring pin SBE 4M conductivity cell to keep the cell clean while stored.

D. See Application Note 70: Installing Anti-Foulant Device Mounting
Kit on SBE 4, 16, 19, and 21 Conductivity Cells, and Appendix V:
AF24173 Anti-Foulant Device

4. (Optional) Mount the SBE 26 in the Sea-Bird mounting fixture:

A. Slide the mooring pin through the SBE 26 lift eye hole in the

direction shown.

B. [Install the retaining ring in the lift eye hole recess, to hold the
mooring pin to the SBE 26. Push part of the retaining ring into the
recess, and hold it in place with a small tool (such as tweezers or
small screwdriver). Using another pair of tweezers, work your way
around the retaining ring, pushing it into the recess.

Rotate the SBE 26 into the mounting fixture as shown.
Screw the mooring pin into the mounting fixture.

Install retaining ring
in recess after
inserting mooring pin

o0

Rotate SBE 26 into
mounting fixture

Screw mooring
pin into mounting
fixture

Mooring pin
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Recovering SBE 26

WARNING!

If the SBE 26 stops working while
underwater, or shows other signs of
flooding or damage, carefully
secure it away from people until you
have determined that abnormal
internal pressure does not exist or
has been relieved. Pressure housings
may flood under pressure due to dirty
or damaged o-rings, or other failed
seals. When a sealed pressure
housing floods at great depths and is
subsequently raised to the surface,
water may be trapped at the pressure
at which it entered the housing,
presenting a danger if the housing is
opened before relieving the internal
pressure. Instances of such flooding
are rare. However, a housing that
floods at 5000 meters depth holds

an internal pressure of more than
7000 psia, and has the potential to
eject the end cap with lethal force.

A housing that floods at 50 meters
holds an internal pressure of more
then 85 psia; this force could still
cause injury.

If you suspect the SBE 26 is flooded,
point the SBE 26 in a safe direction
away from people, and loosen the

3 screws on the connector end cap
about %2 turn. If there is internal
pressure, the end cap will follow the
screws out, and the screws will not
become easier to turn. In this event,
loosen 1 bulkhead connector very
slowly, at least 1 turn. This opens an
o-ring seal under the connector. Look
for signs of internal pressure (hissing
or water leak). If internal pressure is
detected, let it bleed off slowly past the
connector o-ring. Then, you can safely
remove the end cap.

Rinse the SBE 26 with fresh water. See Section 10: Routine Maintenance and
Calibration for (optional) conductivity cell cleaning and storage.
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Uploading Data from Memory

Note:

The SBE 26 communicates at
7 data bits, 1 stop bit, and even
parity, as documented on the
instrument Configuration Sheet.
The baud rate for general
communication is always 9600.

In SEASOFT for Waves’ Run menu, select SeatermW.
SeatermW appears.

Click Configure. The Configuration dialog box appears. Verify/modify
the instrument, Comm port, and upload baud rate (9600, 19200, or
38400). Click OK.

Press the Enter key several times, until the S> displays. This shows
that correct communications between the computer and SBE 26 has
been established.

If the system does not respond with the S> prompt:

e  Click Connect again.

e  Verify the correct instrument and Comm port were selected.

e  Check cabling between the computer and SBE 26.

If the SBE 26 is still logging, command the SBE 26 to stop logging by
typing QL and pressing the Enter key.

The SBE 26 responds:
Stop logging (Y/N)?.
Type y and press the Enter key.

The SBE 26 responds:
Are you sure ("Y/N).
Hold down the Ctrl key and type Y, and press the Enter key

Display SBE 26 status information by clicking Status. The status response
should indicate logdata = no.

Click Upload to upload stored data in a form that SEASOFT for Waves’

data processing modules can use. SeatermW responds as follows:

A. SeatermW sends the status (DS) command, displays the response, and
writes the command and response to the upload file, with each line
preceded by *. DS provides information regarding the number of
samples in memory, sample intervals, etc.

B. SeatermW sends the calibration coefficients (DC) command, displays
the response, and writes the command and response to the upload file,
with each line preceded by *. DC provides information regarding the
sensor calibration coefficients.

C. Inthe Save As dialog box, enter the desired upload file name and
click OK. The upload file has a .hex extension.

D. SeatermW sends the data upload command (DD, DE, or DA,
depending on the upload baud rate you selected in the Configure
dialog box in Step 2), and writes the Hex data to the upload file. The
Status bar displays the progress of the upload, indicating the number
of uploaded lines of data.

Type QS and press the Enter key to put the SBE 26 in quiescent (sleep)
state until ready to redeploy.

Ensure all data has been uploaded by processing the data. See Section 6:
Conversion into Tide and Wave Files — Convert Hex.
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Section 6: Conversion into Tide and Wave
Files — Convert Hex

Note: This section covers converting uploaded raw hex (.hex) data into separate
If desired, use the Term26 module in wave data (.wb) and tide data (.tid) files, with data in engineering units.
SEASOFT for Waves — DOS in place The raw data must be converted and split into separate wave and tide files
of Convert Hex. before further processing by SEASOFT for Waves. Proceed as follows:

1. In SEASOFT for Waves’ Run menu, select Convert Hex. The dialog box
looks like this:

.hex file uploaded from SBE 26 memory. | [Bulyb=ld s s (=R dv R VTR B TS [ i -0l x|

Click Browse to search for file, or type in
path and file name. \
Input file: ||:4datatSBE 2641024, hex | Browse |

utput tide file: {1:%datatSBE 264%:1024.tid
Desired path and file names for output il

tide (.tid) and wave (wb) file. Default utput wave file: |1:data\SBE 2641024 wh BEle

paths and file names are same as input ! I— Calibration
.hex file. If desired, type in path and file Start ear. |2000 A coefficients
name to change it from default. to convert raw
Ready... | Year logging started, in format yyyy (for example, 2000). hex data to
engineering units.

Conversion status bar. —I—>

Convert File Help E xit Cancel

Enter information in the dialog box. Click Coefficients to enter / verify
calibration coefficients for converting raw hex data to engineering units.
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Slope and offset used to make small
corrections for presure sensor drift
between calibrations. Other pressure
sensor calibration coefficients are
hard coded into SBE 26 EPROM, and
cannot be changed; view those
coefficients with DC in SeatermW.

Temperature sensor calibration
coefficients; must match calibration
sheet. Other temperature sensor
calibration coefficients are hard coded
into SBE 26 EPROM, and cannot be
changed; view those coefficients with
DC in SeatermW.

S

2.

Initialization file: |:data\SBE 26\ crwhex. ini

M Prezzure Sensor

1.000000
0.000000

Slope Correction =

Offzet Comection =

— Temperature Calibration Coefficientzs—

a0 = I'l .00a00a
Al = |2.DDEIEIEIEI
3= IS.DDDDDD

OK to return to Convert Hex to Wave and
Tide dialog box.

Open to select a different .ini file.

Save As to save updated .ini file settings.

Save bz

0k | Open I

The Coefficients dialog box looks like this:

Coeffecient Configuration i

|

e

— Conductivity Calibration Coefficients —
Senal Mumnber = IW
L I
H= E

Calibration
coefficients for
optional
conductivity
sensor; must
match calibration
sheet.

PO
= e
CPeor = W
CTcor = IW

Slope = I‘I .ooanan
Offset = |D.DDDDDD
Help | Cancel

Make desired changes. Click OK to return to Convert Hex to Wave and

Tide dialog box.

Notes:
e Sea-Bird ships each new and
recalibrated SBE 26 with a .ini file

that reflects the current calibration.

The .ini file is named with the
instrument serial number, followed

with the .ini extension. For example,
for SBE 26 serial number 2375, we

name the file 2375.ini. You may
rename the file if desired; this will

not affect the results. Click Open in
the Coefficient Configuration dialog

box to select the .ini file.

e Each time you save a .ini file,
Convert Hex copies the file to
CNVHex.ini, in your c:/Windows
directory. The next time you open

Convert Hex, it automatically opens

CNVHex.ini; you can select a
different .ini file if desired.

The SBE 26 configuration (.cfg) file
created by and used with the DOS
terminal program (Term26) contains
calibration coefficients. This .cfg file
cannot be used with Convert Hex. If
converting data for an existing
system that was set up with Term26,
record the calibration coefficients
from Term26 and then reenter the
values in Convert Hex.

Finished conversion.
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Section 7: Tide Data Processing — Merge Barometric Pressure

Section 7: Tide
Merge Barometric

Note:

If desired, use the Merge26 module
in SEASOFT for Waves — DOS in
place of Merge Barometric Pressure.

File to store all information input in File
Setup and Data Setup tabs. Open to
select a different .psa file, Save or
Save As to save current settings, or
Restore to reset all settings to match
last saved version. As a default, .psa

%= Merge Barometric Pressure )

File  Options

File Setup I D'ata Setup I

Data Processing —
Pressure

Merge Barometric Pressure reads in a tide (.tid) file (created with Convert
Hex) and a barometric pressure (.bp) file, and subtracts barometric pressure
from the tide data. The time in the files does not need to be aligned — Merge
Barometric Pressure uses linear interpolation to align the data in time before
subtracting barometric pressure. Merge Barometric Pressure can also convert
tide pressure to water depth in meters, using average density and gravity.

Both the input tide data and output adjusted file have a .tid extension.
However, Merge Barometric Pressure will not process a .tid file that it has
already processed, preventing a user from erroneously removing barometric
pressure multiple times from the tide data.

Remove barometric pressure as follows:

1. In SEASOFT for Waves’ Run menu, select Merge Barometric Pressure.

The File Setup tab looks like this:

=10] x|

Help

file is stored in same directory as
SeasoftWavesLaunch.exe (default is

/

Program setup file

c:/Program Files/Sea-Bird/
SeasoftWaves). SeasoftWaves.ini,
located in Windows directory, contains

]T:\data\SE EZ2E\DATAN 007 4\Merge2BW pea

Open... Save Save bs... Restore

location and file name of last saved
.psa file and options settings for

each module.

Directory and file names for tide (.tid)
data and barometric pressure (.bp)
data. Note that both .tid and .bp files

Input directory
II:'\data'\SB E2ENDATANIOO7S

Select one [.TID) and ane [.BP] input file

J.BP

j Select... I

must be in same directory, but they

can have different names. Select to
pick different files.

Output directary
|I:'~.data'\SB E2ENDATANIOOFA

Select. .. I

Mame append |MinusB arF - -
Directory and file name for output

Clutput file IK.tid

output file name, before .tid

extension. For example, if

Click Start Process to begin
processing data. Status field
shows Processing complete
when done.

processing X.tid and March03.bp
with a Name append of MinusBarP,
output file is XMinusBarP.tid.

}lot processing

(.tid) data. Name append is added to

AN

/ Euit I

N\
Start Process Cancel |

/

/

o |f Confirm Program Set

o If Confirm Program Set

Return to SEASOFT for Waves window.
changes and did not Save or Save As, program asks if you want to save changes.

Save & Exit. If you do not want to save changes, click Cancel to exit.

up Change was selected in Options menu - If you made

up Change was not selected in Options menu - This says

Make the desired selections.
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2. Click on the Data Setup tab. The Data Setup tab looks like this:

EZE Merge Baromekric Pressure

File ©Options Help

If selected, output .tid File Setup  Data Setup |
file contains water depth
in place of pressure. \|7

[rput B arometnc Pressure Lnits

=101 %]

Units in input barometric

Corvert Pressure to ‘W ater Depth pressure (.bp) file —
/

psia or millibars.

Average Density [nominal value = 1028 ka/m™3] |-| EQE»\

Gravity [norminal walue = 9.8 m/s"2) |5_g

Click Start Process to begin
processing data. Status field on
File Setup tab shows Processing
complete when done.

Average density and gravity
value to use to calculate water
depth. Entry is ignored if you
do not select Convert Pressure
to Water Depth.

étart Process F E =it I Cancel

/

Return to SEASOFT for Waves window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

o If Confirm Program Setup Change was not selected in Options menu - This says
Save & Exit. If you do not want to save changes, click Cancel to exit.

Make the desired selections and click Start Process to process the data.

Note:

Merge Barometric Pressure adds
descriptive headings to the
pressure (or depth), temperature,
and optional conductivity and
salinity columns. The presence of
headings in the .tid file indicates
that it has been processed by
Merge Barometric Pressure. See
Appendix IlI: Data Formats.
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Input Barometric Pressure File Format

The required format for the input barometric pressure (.bp) file is:

MM/DD/YY HH:MM:SS P
MM/DD/YY HH:MM:SS P

where
MM = month DD = day YY =year
HH = hour MM = minute SS = second

P = barometric pressure in psia or millibars
(1 standard atmosphere = 14.7 psia or 1013.5 millibars)

Example .bp File:

07/01/94 00:00:00 1015.5
07/01/94 01:00:00 1016.4
07/01/94 02:00:00 1017.3

Merge Barometric Pressure Algorithm

The linear interpolation algorithm is:

Pop = PO + [(t - 10) * (p1 - p0) / (t1 - t0)]
corrected pressure = p - Py
where
t = time of tide sample in .tid file
p = pressure in .tid file at time t
t0 = latest time in .bp file that is less than or equal to t
p0 = barometric pressure at time t0
tl = earliest time in .bp file that is greater than or equal to t
pl = barometric pressure at time t1
Pvp = interpolated barometric pressure

Depth is calculated as:
depth = corrected pressure / (average density * gravity)

See Appendix VII: Pressure-to-Depth Conversion.
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Section 8: Wave Data Processing —
Process Wave Burst Data and Create Reports

Note:

See Appendix VI: Wave Theory
and Statistics for details on the
calculations made by
SEASOFT for Waves.

SEASOFT for Waves includes two wave data processing modules, which are
covered in this section:

Process Wave Burst Data — Compute wave statistics from an input .wb
wave burst file. Output .was statistics and results from auto-spectrum
analysis, .rpt summary report, .wts statistics from surface wave zero
crossing analysis, .wt surface wave time series, and .wss Fast Fourier
Transform coefficients.

Create Reports - Create .126 file with one line of surface wave time series
and/or wave burst auto-spectrum statistics for each processed wave burst,
from input .was and .wts files.

Process Wave Burst Data

Note:

If desired, use the Wave26 module in
SEASOFT for Waves — DOS in place
of Process Wave Burst Data.

Process Wave Burst Data computes wave statistics from an input .wb wave
burst file (created in Convert Hex). Process Wave Burst Data outputs three (or
optionally four or five) files:

Statistics and results from auto-spectrum analysis to a .was file.
Summary report from auto-spectrum analysis to a .rpt file.
Statistics from surface wave zero crossing analysis to a .wts file.
(optional) Surface wave time series to a .wt file

(optional) Fast Fourier Transform coefficients to a .wss file
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Process wave data as follows:

1. In SEASOFT for Waves’ Run menu, select Process Wave Burst Data.
The File Setup tab looks like this:

File to store all information input in File ,

Setup and Data Setup tabs. Oppen to ;Iglil
select a different .psa file, Save or Save | File Options  Help

As to save current settings, or Restore ;
to reset all settings to match last saved e I Data etup |
version. As a default, .psa file is
stored in same directory as

" Program setup file

SeasoftWavesLaunch.exe (default is II:'\data\SBEZE'\D.t‘-‘-.T.-’-‘MDﬂ?d'\PlucessWave%.psa
c:/Program Files/Sea-Bird/
SeasoftWaves). SeasoftWaves.ini, Open... Save Saveds. |  Restoe

located in Windows directory, contains
location and file name of last saved .psa
file and options settings for each module. Input directom

II:'\data'\SBE ZENDATANIOO7 S

Directory and file name for wave (.wb)

data. Select to pick different file. SeECtone el A e

R
| LeR0734. B MR

Output directary

I:hdatahSBE 2ENDATANIO07 S \ Select... |

MHame append I

Eilputle |JAF|D?E|4 —{Directory and file name for output data.

Name append is added to output file name,
before extension. For example, if processing

Click Start Process to begin Mot processing X.wb with a Name append of Wave, output
processing data. Status field | files are testWave.was, testWave.rpt,
shows Processing complete testWave.wts, etc.

when done.

]
\S¢an Process | / Esit | Cancel |
/

/

Return to SEASOFT for Waves window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

o If Confirm Program Setup Change was not selected in Options menu - This says
Save & Exit. If you do not want to save changes, click Cancel to exit.

Make the desired selections.
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2. Click on the Data Setup tab. The Data Setup tab looks like this:

2% Process Wave Burst Data

(n xil

Average temperature and salinity used to
calculate density, required for wave
statistics algorithm.

File ©Options Help

File Setup Data Setup

You may have used Plan Deployment to determine desired
value; see Section 4: Pre-Deployment Planning —
Plan Deployment and Battery and Memory Endurance.

Height of prezsure senzor from battam [meters)

High frequency cutoff for processing wave data,

fmax, is smaller of:

o frequency where (measured pressure /
pressure at surface) < (minimum allowable
attenuation / wave sample duration).

e 1/ minimum period

If getting high frequency noise in output, adjust

minimum allowable attenuation and/or minimum

period. Frequencies > fmax are not processed
unless Use filter cutoff is selected.

Average water temperature above the prezsure senzar [deg C]
verage salinity above the pressure sensor [PSU)

Number of spectral estimates for each frequency band
inimurn allowable attenuation [default = 0.0025]

inimurn period [zecondz] b uze in auto-spectrum [default = 0]

p=—
—
p—
o

Hanning window
suppresses spectral
leakage that occurs
when time series

|D.EID25

-

contains periodic
signal that does not
correspond to one of

exact frequencies
|D-1 /ofFastFourier

Low frequency cutoff fmin = (1 / maximum
period). Frequencies < fmin are not processed
unless Use filter cutoff is selected.

[ tasimum period [seconds] to use in auto-spectium [default = 126) |1 e+0E

Hanning window cutaff [default = 0.1]

Transform.

Chi-zquared confidence percent [default = 90]

ISD 1

Outputting .wt and/or .wss files is

If not selected, all Fourier coefficients for
frequencies > fmax and < fmin are set to 0.

If selected, filter ramps Fourier coefficients down
to O for frequencies > fmax and < fmin.

[~ Output suiface wave time series to . w file ~| optional: other file types (was, .rpt

— |and .wts) are always output.
|r.! 05

™ DOutput FFT coefficients b was file

\r Uze filter cutaff [default = na)

Pracess Options. . |

Select number of wave bursts to process and
number of wave bursts to skip at start of data file.
Default - process all bursts.

Cancel |

Start Process |

Exit I
Return to SEASOFT for Waves window.

o |f Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.
o If Confirm Program Setup Change was not selected in Options menu - This says

Begin processing. Status field on File Setup
tab shows Processing complete when done.

Save & Exit. If you do not want to save changes, click Cancel to exit.

Make the desired selections and click Start Process to process the data.

3. The Verify Setup dialog box appears:

> Surface wawve processing summary':
'f)
et

|

termperature = 0,000
salinity = 35,000
density = 1025, 106
number of points per wawve burst = 1024
sample period = 1.00 sec
sample minimum period = 0.00 sec
sample maximum period = 1e+006 sec
mean pressure = 14,597 psia
instrument depth = 0,000 meters
total water depth = 0.000 mekters
hanning window cukoff = 0, 1000
auto-speckrurn:
5 spectral estimates per band
102 bands calculated
each band is 0,005 Hz wide
frequency span = 0,003 to 0.496 Hz

I= Sebtup QK7

Yes Mo

The dialog box summarizes data from the input .wb file and user inputs from the
Data Setup tab, and shows calculated values for density, number of bands, band
width, and frequency span. Review the summary; click Yes to process data.
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Process Wave Burst Data Algorithm

For each wave burst, Process Wave Burst Data performs an auto
spectrum analysis:

e Reads burst into an array.
e Removes mean, saves mean value.

e Uses mean value, and average water temperature and average salinity
(input by user) to compute density.

e Removes trend.

e Makes array a power of two.

e Applies Hanning window to suppress side-lobe leakage.

e Adjusts scale factor to account for tapering by Hanning window.

e  Fast Fourier Transforms to create raw spectral estimates of
subsurface pressure.

e Computes maximum frequency to process.

e Sets Fourier coefficients greater than maximum frequency or less than
minimum frequency to 0; or
(if Use filter cutoff is selected) applies a filter that ramps the Fourier
coefficients down to 0 for frequencies greater than maximum frequency or
less than minimum frequency

e Saves Fourier coefficients.

e Band averages raw spectral estimates to create auto-spectrum.

e Applies dispersion transfer function to band center frequencies.

e Calculates wave statistics from auto-spectrum: variance, energy,
significant wave height, and significant period.

Using the saved (non-band-averaged) Fourier coefficients, Process Wave
Burst Data performs a surface wave zero crossing analysis:

e  Applies dispersion transfer function to each frequency.

e Inverse Fast Fourier Transforms to create surface wave time series.
e Applies inverse Hanning window and adjusts scale factor.

e  Zeroes all elements where inverse Hanning factor is greater than 10.

e Performs zero crossing analysis of surface wave time series to create an
array of individual waves and their corresponding periods.

e Sorts wave array in ascending order.

e (Calculates wave statistics from surface wave time series:
average wave height, average period, maximum wave height,
significant period, significant wave height Hy5, Hy/10 , Hyj00-
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Create Reports: Summarize Wave Data

Note:

If desired, use the Report26 module
in SEASOFT for Waves — DOS in
place of Create Reports.

Create Reports creates a file containing one line of surface wave time series
and/or wave burst auto-spectrum statistics for each processed wave burst. The
input .wts file contains surface wave time series statistics and the input .was
file contains wave burst auto spectrum statistics (these files are created in
Process Wave Burst Data). The output .r26 file format is user-defined and can
contain one or more of the following variables:

Variable Column Label
Time Time
burst number burst
pressure sensor depth depth
number of waves nwaves
variance var-wts
From Surface Wave Energy energy-wts
Time Series Statistics average wave height avgheight
(.wts) File average wave period avgper
maximum wave height maxheight
significant wave height swh-wts
significant wave period SWp-wts
H, H1/10
H, 100 H1/100
From Wave Burst variance var-was
Auto-Spectrum Statistics ___Shetey CneTEy-was
(was) File S}gn?ﬁcant wave he1ght swh-was
significant wave period SWp-was
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Setup and Data Setup tabs. Open to
select a different .psa file, Save or Save
As to save current settings, or Restore
to reset all settings to match last saved
version. As a default, .psa file is

stored in same directory as
SeasoftWavesLaunch.exe

(default is c:/Program Files/Sea-Bird/
SeasoftWaves). SeasoftWaves.ini,
located in Windows directory, contains
location and file name of last saved .psa
file and options settings for each module.

Proceed as follows:

1.

File to store all information input in File 2T :r 12

File  Options

File: Setup | Data Setup I

In SEASOFT for Waves’ Run menu, select Create Reports. The File
Setup tab looks like this:

=131 x|

Help

I§
“Frogram setup file

II:\data‘xS BEZENDATAM reateFeports. psa

Open...

Save I Save As... Festore I

Input directaory

Directory and file name for wave (.was
and .wts) data. Select to pick different file.
Note that both .was and .wts files must be
selected, even if you intend to output
variables from only one of the files. Files
must be in same directory, and must have
same name (before extension).

Jy.\data'\s BEZ2EA\DATAN 0074
Select one [WAS] and one [WT 5] input file

/

TPERO7I4wAS

j Select... I

Output direckory

Click Start Process to begin
processing data. Status field
shows Processing complete
when done.

II:\data'\S BEZEA\DATAN 0074
Mame append I

Output file

\ Select . |

|J»‘-‘«F|D?‘EI4.r2Ei Directory and file name for output data.

Name append is added to output file name,

before extension. For example, if processing

Mot processing

X.was and X.wts with a Name append of

Wave, output file is XWave.r26.

N\
Start Process |

| Cancel |

}EHit
/

/

Return to SEASOFT for Waves window.

o If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

o If Confirm Program Setup Change was not selected in Options menu - This says
Save & Exit. If you do not want to save changes, click Cancel to exit.

Make the desired selections.
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2. Click on the Data Setup tab. The Data Setup tab looks like this:

- - = = b
If selected, output .r26 file contains labels , Cre=t Re'mrs =131
i Opki H - X
above data columns (labels match Lt A If selected, output .r26 file contains a
variable names in Select Variables File Setup  Diata Setup I descriptive text header that includes input
file name and path, wave integration

dialog box).
time, number of paints in burst, height of

Label Data Columns -
/ SBE 26 above bottom, and water density.
¥ Dutput Header Informatio

Separate each variable in output Column separator Im

.r26 file with a space, tab,

semi-colon, or colon. Julian dayps conversion farmat IJu“an daps \ j
% elect Variables.. | Output date and time as Julian days,
L hh:m,m:ss (hours, minutes, seconds),

or dd mmm yyyy hh:mm:ss (day,
month, year, hours, minutes, seconds).

Click to bring up a list of variables.

See Step 3 below.

Click Start Process to begin
processing data. Status field
shows Processing complete
when done.

/ Eit Caned
/

/

Return to SEASOFT for Waves window.

¢ If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

¢ |f Confirm Program Setup Change was not selected in Options menu - This says
Save & Exit. If you do not want to save changes, click Cancel to exit.

Make the desired selections.
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3. Click Select Variables. The Select Variables dialog box looks like this:

Select ¥ariables i

Dielete

Inzert

Col # Yariable Mame [unit] | Add
1 Average Period [geconds], time series statistics
2 Burst Number
3 Date/Time
4 Significant wawve height [meters], auto spectrum

11
12
13
14
15
16

—_

Delete Al

L

Click a variable and click Add to add it to list of output

variables on left.

* [f you select energy, significant period, significant
wave height, or variance, Create Reports requires you
to select whether to calculate variable from wave burst
auto-spectrum (.was) or wave time series (.wts).

~ Average Period [seconds], time series statistics
Average Wave Height [meters], ime senes statistics
Burst Murmber

Date/Time

Energy [J/m™2)

H1410 [meters], time series statistics

H1/100 [meters], time series statistics

b axirnunn Wave Height [meters], ime series statistics
Mumber of waves, bme zeries statistics

Pressure Sensor Depth [meters]

Significant period [zeconds]

E| Significant wave height [meters]

Yariance

l | 4]

x|
Shirink Al |
Expand All |
Shirink. |
Expand |

Cancel

Make the desired selections and click OK to return to the Create Reports

data setup tab.

4. Click Start Process to process the data.
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Section 9: Data Plotting — Plot Data

Note: Plot Data displays and plots data from files with a .tid, .wb, .was, .wts, or .wt
If desired, use the Plot26 module in file extension. Plot Data:
SEASOFT for Waves — DOS in place e Plots up to five variables on one plot, with one X axis and up to

of Plot Data. four Y axes.

e Zooms in on plot features.

e Sends plots to a printer, saves plots to the clipboard for insertion in
another program (such as Microsoft Word), or saves plots as graphic files
in bitmap, metafile, or JPEG format.

In SEASOFT for Waves’ Run menu, select Plot Data. Each tab of the dialog box
is described below, as well as options for viewing, printing, and saving plots.

File Setup Tab

File to store all information input in The File Setup tab defines the Program Setup file, input data file(s), and output
File, Plot, and Axis tabs. Open to plot file name. The File Setup tab looks like this:
select a different .psa file, Save or
Save As to save current settings, =101 ]
or Restore to reset all settings File Options Help
to match last saved version.
As a default, psa file is stored File Setup | Flot Setup | % duis | v dwis 1] ¥ dwis 2|
in same directory as
SeasoftWavesLaunch.exe Program setup fils
(default is c:/Program Files/Sea- ™S -
Bird/Seasoftwaves). |C:\Dncuments and Settings dbresko'My DocumentshPlotD atatest psa
SeasoftWaves.ini, located in
Windows directory, contains Open... Save Save bs... Restare
location and file name of last
saved .psa file and options
settings for each module. Input directary
)):\data\SEE2E\DATA
Directory and file names for input Input files, 2 selected
data files (.tid, .wb, .was, .wts, and I =lFET:
/ or .wt files). Al files must be in [EATELTID 7| [ Sekect. |
same directory and have same
name before extension. Select to :
pick different files. Output directary
C:ADocuments and Settingstdbresk oMy Documents \ Select... |
Mame append \

Default directory and file name (can be changed while viewing plot) for outputting
graphic file in .wmf, .jpg, or .omp format. Default file name is set to match input file
Mot proceszing |name, with additional characters added before extension, in order listed below:
 Name append, to allow user to add descriptive information to file name.
/ ¢ Plot type (as for Auto Spectrum, tts for Tide Time Series, ws for Wave Statistics, or

wts for Wave Time Series).
e Wave burst number for types that have a plot for each wave burst

Click Start Process to begin For example, if processing X.tid, X.wb, X.was, X.wts, and X.wt with a Name Append

processing data. Status field of Color and outputting .jpg files, output file names are XColorAs-0.jpg,

shows Processing complete XColorAs-1.jpg, etc. (Auto Spectrum: 1 file for each selected wave burst);

when done. XColorTts.jpg (Tide Time Series); XColorWs.jpg (Wave Statistics); XColorWts-0.jpg,
XColorWts-1.jpg, etc. (Wave Time Series: 1 file for each selected wave burst).

\ .
Start Prucessl it Cancel

Z
Return to SEASOFT for Waves window.
o |f Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.
o If Confirm Program Setup Change was not selected in Options menu - This says
Save & Exit. If you do not want to save changes, click Cancel to exit.
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Plot Setup Tab

The Plot Setup tab defines the plot type, data to be included, and plot layout
(title, color, font, grid lines, etc.). The Plot Setup tab looks like this:

B Plot Data

File Options Help

User input Plot title.

User selected Title color.

Select Add file name to title to add
input data file name to user input title.
For example, for a plot titte Wave Time
Series with input file X.wb, if you select
Add file name to title, title is

Wave Time Series, X.wb.

File Setup Plot Setup [ auds | ¥ s

1] ¥ s 2

Plat type I'w'ave Time Seri&”:l/

=0t x|

Available selections dependent on input
file types selected on File Setup tab:

e Wave Time Series

¢ Tide Time Series

e Auto Spectrum

o Wave Statistics

(_Flot title |Wave Time Series Plat

Plot Font type and Font size (small,
medium, or large). Plot Data displays
example of font type to right of
selection. List of fonts depends on what
fonts are installed on your computer.

Inside Background Color defines color
within axes. Outside Background Color
defines color outside axes.

Title Caler... |. ¥ Add fle name to tile

It Inzide Background Colar... | |:|

Outzide Backgr

| Fontlee faiy ~| |AaBbCeDdEeFf-012345

Font size |Sma|| vI Grid lines (none, horizontal and vertical, horizontal,
vertical). Grid style (solid, dotted, or dashed line),
and whether to place Grid in front of plotted data.

Gridlines [} : /_"I/ -

|H|:|r|2|:|nla| and Yertical Symbol plotting
: e f
Grid sty [Thin Soid Line | | Giidin front 02 oast

(0 = least frequent,
9 = most frequent),
if Monochrome plot
selected. If too frequent,

ound Colar... | |:|

Size (small, medium, large) of symbol
for each variable, if Monochrome plot or
Plot symbols only selected.

Monochrome plot: Substitute black
lines with symbols for colors (colors
and symbols defined on Axis tabs).
Allows you to set up axes with colors
for viewing on screen, and then
switch to black lines with symbols for
black and white printing.

Plot symbols only: Mark each
individual data point with a symbol,
and do not connect symbols with a
line (symbols defined on Axis tabs).
Show line legends: Show legends
below plot title. Legend indicates line
color or symbol, as applicable.

[ Mark data points

Auta range padding % JE_:’

L Symbal size |'5ma|| r| Symbol frequency I@/

| [ Monochrome plot T Plat symbols anly

[ Shaw plot shadaw

Process Ophons... |

symbols create illusion
of very thick line,
making details difficult
to see.

¥ Show line legends

Mark data points: Mark
each individual data point
with a dot, and connect
dots. If not selected, Plot
Data just draws a

Space between axes and
maximum and minimum plotted
values, if Auto range selected
on Axis tabs.

For 0%, maximum and
minimum values plot on axes.

7
Select number of wave
bursts or tide scans to
process and number to

skip at start of

Default is to process

all data.

St@n Process
N\

continuous line between
data points.

Show plot shadow: Create
shadow effect to bottom
and right of axes.

data file.

Exwit Cancel

/

/

\

VA

Click Start Process to begin
processing data. Status field
shows Processing complete
when done.
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Return to SEASOFT for Waves window.
If Confirm Program Setup Change was
selected in Options menu - If you made
changes and did not Save or Save As,

program asks if you want to save changes.
If Confirm Program Setup Change was not
selected in Options menu - This says Save &
Exit. If you do not want to save changes, click

Cancel to exit.




Section 9: Data Plotting — Plot Data

X Axis Tab

Select to label axis with variable
name as listed in drop down
Variable list, or enter Custom label
for axis.

Click on the X Axis tab. The X Axis tab defines the plot style as well as the
X axis variable, scale, and line type.
The X Axis tab looks like this for Wave Time Series, Tide Time Series, or

Wave Statistics:

EZ Plot Data b

File Options Help

File Setup | Plot Setup s | v s 1] v s 2

Warishle | S [zeconds]

r

Plot Style: (& Overlay

w | abel axiz with variable name

=10 ]|

Selection dependent on Plot type selected
on Plot Setup tab:
e Wave Time Series — time (seconds)
e Tide Time Series — date and time
e Wave Statistics — burst number or
date and time

Stacked e Overlay — overlay plot for all Y axis
— ————1 variables on one plot, or
e Stacked - create a separate plot for
each Y axis variable, with plots
stacked vertically above each other.

Custam label I

Select desired line type, color, and

Line type IThin Salid

e Auto range - Plot Data selects
axis Minimum and Maximum
values, number of Major
divisions on axis, and number
of Minor divisions between
Major divisions.

e Auto divisions - Plot Data
selects number of major
divisions on axis, and number of
minor divisions between major
divisions. User selects axis
Minimum and Maximum values.

Any values that fall outside user-

selected Minimum to Maximum

range will plot at minimum or
maximum, as applicable.

/7 Auto rahge Minirmum
I &eirnarn
\{7 Auto divisions Majar
b iror

Line Color... | [ Unesymbel [5oiotioe

symbol. Selection of color or
monochrome plot, and inclusion of
{symbols in plot, is made on Plot
Setup tab, and applies to all axes.

-
—l

jo.o000

[foo0n

|4_
-

Stan\ Process |
N\

Y Exit I Cancel

/

N\

/

Click Start Process to begin
processing data. Status field
shows Processing complete
when done.

Return to SEASOFT for Waves window.

¢ If Confirm Program Setup Change was
selected in Options menu - If you made
changes and did not Save or Save As,
program asks if you want to save changes.
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¢ If Confirm Program Setup Change was not
selected in Options menu - This says Save &
Exit. If you do not want to save changes, click
Cancel to exit.




Section 9: Data Plotting — Plot Data

The X Axis tab looks like this for Auto Spectrum:

EEE Plot Data

File Options Help

File Setup | Plot Setup % Avis | ¥ 4is 1 |

Yariahle

If selected, confidence intervals
and burst parameters display in
text at right of a 2D plot.

Plot Style: & Overdap 2D Overap 30

{ Include chi-zquared confidence intervals
Dizplay Burst Parameters

Select to label axis with variable
name as listed in drop down
Variable list, or enter a Custom
label for axis.

\

=101 ]

Selection dependent on Plot type
selected on Plot Setup tab:
e Auto Spectrum — frequency (Hz)

Overlay 2D — 2D plot of frequency and
energy density

Overlay 3D — 3D plot of frequency,
energy density, and either burst
number or date and time

{ Label axiz with varable name
Lztom label |

Select desired line type, color,

Line type IThin Salid |

and symbol. Selection of color
or monochrome plot, and

Line Calor.... |. Line symbal I'Sc.lid Circle

e Auto range - Plot Data selects
axis Minimum and Maximum
values, number of Major
divisions on axis, and number
of Minor divisions between
Major divisions.

e Auto divisions: - Plot Data
selects number of major
divisions on axis, and number of
minor divisions between major
divisions. User selects axis
Minimum and Maximum values.

Any values that fall outside user-

selected Minimum to Maximum

range will plot at minimum or
maximum, as applicable.

¥ Awto range Miriraurn |IZI.L'IUEIE'

M azirnum |-|[| ooon
v Auto divisions I ajor |4_

bdinor |-|_

j inclusion of symbols in plot, is
made on Plot Setup tab, and
applies to all axes.

Start Process
N\

, E it I Cancel

/

Click Start Process to begin
processing data. Status field
shows Processing complete
when done.
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Return to SEASOFT for Waves window.

¢ If Confirm Program Setup Change was
selected in Options menu - If you made
changes and did not Save or Save As,
program asks if you want to save changes.

¢ If Confirm Program Setup Change was not
selected in Options menu - This says Save &
Exit. If you do not want to save changes, click
Cancel to exit.
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Y Axis Tab

Include this axis in plot. Plot Data
can plot 1 X and up to 4 Y axes.
Atleast 1X and 1Y variable

is required, so this selection

is available only on

Y Axis 2, 3, and 4.

Note: If you deselect an axis, all
axes numbered above that axis
are automatically deselected.

Select to label axis with variable
name as listed in drop down
Variable list, or enter a Custom
label for axis.

e Autorange - Plot Data selects
axis Minimum and Maximum
values, number of Major
divisions on axis, and number
of Minor divisions between
Major divisions.

e Auto divisions - Plot Data
selects number of major
divisions on axis, and number
of minor divisions between
major divisions. User
selects axis Minimum and
Maximum values.

Any values that fall outside user-

selected Minimum to Maximum

range will plot at minimum or
maximum, as applicable.

The Y Axis tabs define the Y axis variables, scales, and line types.

W Include axiz
B

EZ% Plot Data b

File Options Help

File Setup | Plot Setup | = Auis | ¥ auis 1 ¥ Awis 2 | Auis 3| Y wis 4 |

=10l x|

W arisble |Energ_l,l [J/m™2], auto zpectium

[w Label axis with «ariable name

|

Selection dependent on Plot type
selected on Plot Setup tab.

Cuztom label |

Line type

[ Thin Solid =l

Select desired line type,
color, and symbol. Selection
of color or monochrome
plot, and inclusion of

Line Calar... I . Line symbol ISuIi-:I L pward Triangle j

symbols in plot, is made on
Plot Setup tab, and applies
to all axes.

W Autorange Finirnum

jo.0000

Masimum [0

¥ futo divisions: Major |4

Finor |-|_

Start F"\ru-::ess |
\

/E:-:it I Cancel

/

N\

/

Click Start Process to begin
processing data. Status field
shows Processing complete
when done.
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Return to SEASOFT for Waves window.

If Confirm Program Setup Change was
selected in Options menu - If you made
changes and did not Save or Save As,
program asks if you want to save changes.

If Confirm Program Setup Change was not
selected in Options menu - This says Save &
Exit. If you do not want to save changes, click
Cancel to exit.
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Viewing and Outputting Plots

EL Plot Data Yiew ' _

DOukput Oplions Yiew
Luaue TIme Zerie= Plot, 212H.0E, 21 2H.WT
Eurst O, Start12 Feb 1008 02:11:20, 4004 point, T=1024 =ec
i | I I
N \ Double click on plot title, and
0.04 Use View menu or keyboard Plot Setup tab appears,
5 Arrow, Home, or End keys to allowing you to make
[ switch between plots for each changes and reprocess data.
0.03 wave burst. '
o.o2 + |
= 0o
t
‘5 0.00 A
Ny
E-u G Zoom in to enlarge
s} f details by clicking and
z [ dragging to select a
g ooz 1 Double click on an axis or axis label (wave rectangular area. ||
F amplitude, time, etc.), and appropriate Axis tab Plot Data zooms in on
[ appears, allowing you to make changes and that area. You can
-oo3 4 reprocess data with new plotting parameters. zoom in several times ||
[ before reaching
F k program limits. Undo
-0.04 zoom by selecting Undo |—
[ \ Zoom in View menu.
-0.05 + "
: 1_1 11 1 11 1 1_1 1_1 1 11 1 \ 11 1 11 1 11 1_1 1 1 11 1 1_1 1 11 11 1 1_1
] 100 200 oo 400 \4 500 a00 700 200 oo 1000
Time [*econd=]

The Plot Data View window’s menus are described below:

Output — Output the plot to printer, clipboard, or a file.

e  Print — Print the single plot that is displayed on screen. In the dialog box,
select printer, orientation, color, etc.; these selections override selections
you made in Plot Data and in the Plot Data View Options menu.

e File — Output to file the single plot that is displayed on screen, in the
selected format (.wmf, .jpg, or .bmp). In the dialog box, select the desired
directory and output file name; these selections override selections you
made in Plot Data and in the Plot Data View Options menu.

e Clipboard — Output to the clipboard the single plot that is displayed on
screen, in the selected format (.wmf, .jpg, or .bmp). The selected format
overrides the selection you made in the Plot Data View Options menu.

Notes: e Print Range (for wave time series and auto spectrum plots) — Print plots

e The first wave burst is labeled 0.

e To change the default printer in
Windows XP: Click Start / Printers
and Faxes. A list of printers
installed on your system appears,
with a check mark next to the
default printer. Right click on the
desired printer, and select Set as
Default Printer.

for several wave bursts for the series that is displayed on screen. In the
dialog box, select the wave burst print range. Orientation and size are as
selected in the Plot Data View Options menu. Plots output to your
system’s default printer; to output to a different printer you must select a
new default printer before you select Print Range.

File Range (for wave time series and auto spectrum plots) — Output to file
the plots for several wave bursts for the series that is displayed on screen,
in the selected format (.wmf, .jpg, or .bmp). In the dialog boxes, select the
wave burst file output range, and the desired directory and output file
name. Directory and file name selections override selections you made in
Plot Data and in the Plot Data View Options menu.
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Options — Sets up defaults for how the plot is output to the printer, file,
or clipboard.
e Print-
» Orientation — landscape, portrait, or (printer) driver default.
If driver default is selected, orientation is determined by the default
for the printer you select in Output / Print (if printing a single plot)
or the system default printer (if printing multiple plots using
Output / Print Range).
> Print full page — If selected, scale plot to fit 8 2 x 11 inch page.
If not selected, Size determined by -
Plot Data View Dimensions — plot dimensions as shown on screen.
Values Entered Below — Units, Width, and Height entered here.
o File—-
» Data format — Metafile (.wmf), Jpeg (.jpg), or Bitmap (.bmp).
» Size determined by -
Plot Data View Dimensions — plot dimensions as shown on screen.
Values Entered Below — Units, Width, and Height entered here.
e Clipboard -
» Data format — Metafile (.wmf), Jpeg (.jpg), or Bitmap (.bmp).
» Size determined by -
Plot Data View Dimensions — plot dimensions as shown on screen.
Values Entered Below — Units, Width, and Height entered here.

View — Sets up viewing options.

e  First Burst, Last Burst, Next Burst, Prior Burst, Go to Burst (applicable to
wave time series and auto spectrum plots) — Switch the plot on screen to a
different wave burst.

e Undo Zoom —Return the plot to the original ranges specified on the Axis
tabs. Undo Zoom is grayed out unless you have zoomed in (by clicking
and dragging to select a rectangular area) to enlarge details.

e Set Zoomed Ranges — Substitute the current zoomed ranges of the plot for
the Minimum and Maximum plot ranges on the Axis tabs. This allows you
to save the ranges of the zoomed view, so you can go to exactly the same
view the next time you run Plot Data. Set Zoomed Ranges is grayed out
unless you have zoomed in (by clicking and dragging to select a
rectangular area) to enlarge details.
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Section 10: Routine Maintenance

and Calibration

This section reviews corrosion precautions, connector mating and
maintenance, battery replacement, pressure sensor maintenance, optional
conductivity cell storage and cleaning, and sensor calibration. The accuracy of
the SBE 26 is sustained by the care and calibration of the sensors and by
establishing proper handling practices.

Corrosion Precautions

Rinse the SBE 26 with fresh water after use and prior to storage.

For both the plastic and titanium housing, all exposed metal is titanium
(the plastic housing has a titanium end cap). No corrosion precautions are
required, but avoid direct electrical connection of the titanium to dissimilar
metal hardware.

The optional SBE 4M conductivity cell has an aluminum or titanium housing.
The aluminum housing has a ring-shaped zinc anode. Check the anode
periodically to verify that it is securely fastened and has not been dissolved.

Connector Mating and Maintenance

CAUTION:

Do not use WD-40 or other
petroleum-based

lubricants, as they will
damage the connectors.

A mated connector does not require periodic disassembly or other attention.
Inspect a connector that is unmated for signs of corrosion product around the
pins. When remating:

1. Lightly lubricate the inside of the dummy plug/cable connector with
silicone grease (DC-4 or equivalent).

2. Standard Connector - Install the plug/cable connector, aligning the
raised bump on the side of the plug/cable connector with the large pin
(pin 1 - ground) on the MicroCAT. Remove any trapped air by burping or
gently squeezing the plug/connector near the top and moving your fingers
toward the end cap. OR
MCBH Connector — Install the plug/cable connector, aligning the pins.

3. Place the locking sleeve over the plug/cable connector. Tighten the
locking sleeve finger tight only. Do not overtighten the locking sleeve
and do not use a wrench or pliers.

Verify that a cable or dummy plug is installed for each connector on the
system before deployment.
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Battery Replacement

The SBE 26 uses 9 alkaline D-cells (Duracell MN1300, LR20), dropped into

the battery compartment.
Alkaline D-cell

, (MN1300, LR20) Leave the batteries in place when storing the SBE 26 to prevent depletion of

the back-up lithium batteries by the real-time clock. Even exhausted main
batteries power the clock (90 microamperes) almost indefinitely. If the SBE 26
is to be stored for long periods, leave the batteries in place and replace them
yearly.

1. Remove the battery end cap (end cap without connectors):
A. Wipe the outside of the end cap and housing dry, being careful to
remove any water at the seam between them.
B. Remove the end cap by rotating counter-clockwise (use a wrench on
the white plastic bar if necessary).
Unthread cap by C. Rempve any water from the O-ripg mating surfaces inside the
rotating counter- housing with a lint-free cloth or tissue.
clockwise D. Put the end cap aside, being careful to protect the O-ring from
damage or contamination.

2. Remove the battery cover plate from the housing:
A. Remove the three Phillips-head screws and washers from the battery
cover plate inside the housing.
B. The battery cover plate will pop out. Put it aside.

3.  Turn the SBE 26 over and remove the batteries.

4. Install the new batteries, with the + terminals against the flat battery
contacts and the - terminals against the spring contacts.

5. Reinstall the battery cover plate in the housing:

A. Align the battery cover plate with the housing. The posts inside the
housing are not placed symmetrically, so the cover plate fits into the
housing only one way. Looking at the cover plate, note that one screw
hole is closer to the edge than the others, corresponding to the post
that is closest to the housing.

B. Reinstall the three Phillips-head screws and washers, while pushing
hard on the battery cover plate to depress the spring contacts at the
bottom of the battery compartment. The screws must be fully
tightened, or battery power to the circuitry will be intermittent.

_Re-r-nove Phillips-head

screws and washers

6. Check the battery voltage at BAT + and BAT - on the battery cover plate.
It should be approximately 13.5 volts.

7. Reinstall the battery end cap:

A. Remove any water from the O-rings and mating surfaces with a lint-
free cloth or tissue. Inspect the O-rings and mating surfaces for dirt,
nicks, and cuts. Clean or replace as necessary. Apply a light coat
of o-ring lubricant (Parker Super O Lube) to O-rings and
mating surfaces.

B. Carefully fit the end cap into the housing and screw the end cap into
place. Use a wrench on the white plastic bar to ensure the end cap is
tightly secured.
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Pressure Sensor Maintenance

Pressure sensor port

The pressure fitting — which includes a pressure port fitting, external tube, and
polyurethane bladder bag — is filled with silicone oil at the factory. The oil
transmits hydrostatic pressure via internal, capillary tubing to the pressure
sensor inside the instrument, and prevents corrosion that might occur if

the sensor diaphragm was exposed to water. The bladder bag is vacuum
back-filled.

The bladder bag can develop tears and leaks over time. If the fitting has been
damaged, or investigation due to poor data shows that the bag has torn, replace
the fitting and bag and refill the oil. Sea-Bird highly recommends that you
send the SBE 26 back to the factory for this repair, as it is difficult to
completely remove all air from the system in the field, resulting in
potential pressure errors. However, if you must do the repair to meet a
deployment schedule, contact Sea-Bird to purchase the needed parts.

Connector End Cap

Parts required:

Part I .
Number DESCTIptIOI'l Quantlty
30551 Pressure port bladder bag 2%
50025 Pressure sensor oil refill kit ** 1
50029 Nylon capillary assembly 2%
30002 Swagelock, nylon, NY-200-1-OR 2*
Syringe, 60 cc, DURR #899069, MFG #309663
30521 1
(18 gage needle ground)

* Only 1 is required, but we recommend that you purchase a spare in case you
have difficulty with the procedure.
** If you have a bell jar, use it to de-gas the oil in the oil refill kit.

3 Pressure
@ ) cover 1. Securely mount the SBE 26 vertically (connector end cap up).
Lifting eye
2. Remove the 3 Phillips-head screws attaching the pressure tube guard

to the lifting eye. Remove the pressure tube guard and the pressure

cover that is under it.

Pressure @
tube guar

Pressure

bag 3. Remove the fitting from the end cap with a 9/16 inch wrench. Discard

the fitting, tubing, and pressure bag.
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CAUTION: 4.
Do not put a brush or any object in the
pressure port. Doing so may damage or
break the pressure sensor.

5.
6.
Meniscus
-
"
should
overflow 7.
from top of X
tube % ! &

mst

.70. Remove

4 Wwith7/16

inch wrench

7B. Tighten
with 9/16
tach wrench 3

TN

tube through
| fitting and over oil; check
needle for air
bubbles

A

-‘ 9B. Draw
- vacuumon
bag until flat

Clean the pressure bag cavity in the lift eye and the removed pressure
tube guard and pressure cover, removing all residue/grit. Ensure that
the holes in each corner of the pressure bag cavity in the lift eye are
free of obstructions.

Clean the sensor end cap, being careful to remove any residue/grit
near the pressure port.

From the 50025 pressure sensor oil refill kit, fill the small syringe
with the supplied oil. Fill the pressure port, forming a meniscus on
the surface of the end cap. Keep the SBE 26 in the vertical position
for at least 30 minutes before proceeding, to allow any bubbles in the
internal plumbing to rise to the surface. Add oil from the small
syringe as necessary to maintain the meniscus.

Install the supplied capillary fitting (50029) in the pressure port.

A. As the fitting is installed, oil should rise the length of the tube
and overflow. Wipe up the excess oil with a paper towel.

B. Gently tighten the lower portion of the fitting with a 9/16 inch
wrench - DO NOT OVERTIGHTEN.

C. Remove the upper portion of the capillary fitting and tube using a
7/16 inch wrench. Store it for possible use another time.

Using the small syringe, add oil to the lower portion of the fitting,
forming a meniscus.

Fill the large syringe (30521) Y4 full with oil.

A. Thread the tube from the pressure bag (30551) through the
Swagelock fitting (30002), and install the pressure bag tube over
the needle.

B. Pull the plunger back on the syringe, drawing a vacuum on the
pressure bag until it is completely flat. Maintain the vacuum on
the bag.

Hold the syringe vertically with the bag down and slowly release
the plunger, allowing the vacuum to be released. The bag should
slowly fill with oil. There is enough oil in the bag when the bag
looks like a small pillow. It is very important that there are no air
bubbles in the pressure bag; you may have to perform this step
several times to ensure that there are no bubbles.
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10. After the bag is filled, gently remove the tube from the needle,
keeping the bag at or below the level of the end of the tube to prevent

Maintain gentle | air from entering the bag. Maintaining gentle pressure on the bag to
pressure on

keep the oil at the end of the tube and prevent air from entering the
bag, insert the end of the tube into the lower portion of the fitting on
the end cap and screw the Swagelok fitting down, using a 7/16 inch
wrench. Oil should overflow from the fitting, preventing air from
entering the bag; the overflow should stop when the fitting is
tightened. When completed, the bag should be approximately ' full
of oil and contain no air.

11. Install the pressure bag in the pressure bag cavity. Place the tubing in
Pressure the indent, going counter-clockwise from the bag to the fitting.

bag

Pressure e 12. Reinstall the pressure cover, pressure tube guard, and 3 Phillips-head
cover @ ! screws, being careful not to pinch the tubing or the bag.
e | Lifting eye
-

Pressure @

tube gu, r&\ |
J ¥ 0%

13. Log data on the SBE 26, and download the data. Compare the
pressure readings to a local barometer. A pinched or overfilled bag
will give pressure readings that are higher that the correct values.
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Conductivity Cell Maintenance

The SBE 26’s optional conductivity cell (SBE 4M) is shipped dry to prevent

freezing in shipping. Refer to Application Note 2D: Instructions for Care and
Cleaning of Conductivity Cells for conductivity cell cleaning procedures and

cleaning materials.

CAUTIONS:

e Do not put a brush or any object
inside the conductivity cell to
dry it or clean it. Touching and
bending the electrodes can

change the calibration. Large e The Active Use (after each cast) section of the application note
bends and movement of the is not applicable to the SBE 4M, which is intended for use as a
electrodes can damage the cell. moored instrument.

¢ Do not store the SBE 4M with
water in the conductivity cell.
Freezing temperatures (for
example, in Arctic environments or
during air shipment) can break the
cell if it is full of water.
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Sensor Calibration

Note:

After recalibration, Sea-Bird
ships the instrument back to the
user with an updated .ini file (for
use in Convert Hex) and new
Calibration Certificates showing
the new coefficients.

Note:

Although the pressure sensor
manufacturer can re-calibrate
the pressure sensor by
duplicating the original
procedures, the sensor must be
removed from the SBE 26, the
cost is relatively high, and lead
times can be considerable.

Sea-Bird sensors are calibrated by subjecting them to known physical
conditions and measuring the sensor responses. Coefficients are then
computed, which may be used with appropriate algorithms to obtain
engineering units. The pressure, temperature, and optional conductivity
sensors on the SBE 26 are supplied fully calibrated, with coefficients printed
on their respective Calibration Certificates (in manual).

We recommend that the SBE 26 be returned to Sea-Bird for calibration.

Quartz Pressure Sensor Calibration

The pressure sensor is capable of meeting the SBE 26’s error specification
with some allowance for aging and ambient-temperature induced drift. The
pressure sensor is supplied with coefficients derived from a calibration
performed over temperature (0 - 125 °C). When used in the quartz sensor
temperature model (as incorporated in Sea-Bird software), these coefficients
reflect the initial calibration of the sensor.

The pressure sensor coefficients are hard coded into the SBE 26. These can be

viewed using DC in SeatermW, but cannot be changed by command.

However, values for slope (default = 1.0) and offset (default = 0.0) can be

entered in Convert Hex’s Coefficient Configuration dialog box to make small

corrections for sensor drift. Techniques are provided below for making small

corrections using the slope and offset terms by comparing SBE 26 pressure

output to:

e Readings from a barometer

e Readings from a dead-weight pressure generator — provides more accurate
results, but requires equipment that may not be readily available

Before using either of these procedures, allow the SBE 26 to equilibrate in a
reasonably constant temperature environment for at least 5 hours before
starting. Pressure sensors exhibit a transient change in their output in response
to changes in their environmental temperature. Sea-Bird instruments are
constructed to minimize this by thermally decoupling the sensor from the body
of the instrument. However, there is still some residual effect; allowing

the SBE 26 to equilibrate before starting will provide the most accurate
calibration correction.

Calculating Offset using a Barometer

1. Place the SBE 26 in the orientation it will have when deployed.
In SeatermW, connect to the SBE 26.

3. Send FR to display the pressure and pressure sensor temperature
compensation frequencies. Click Stop to end the test.

4. Compute pressure in psia from the frequency with the formula shown on
the calibration sheet.

5. Compare the SBE 26 output to the reading from a good barometer.
Calculate Offset = barometer reading — SBE 26 reading.

6. Enter the calculated offset (positive or negative) in Convert Hex’s
Coefficients Configuration dialog box.

Offset Correction Example
Pressure measured by barometer is 1010.50 mbar. Pressure calculated from SBE 26 pressure frequency is 14.06 psia.
Convert barometer reading to psia using relationship: mbar * 0.01 dbar/mbar * 1 psia / 0.689476 dbar = psia
Barometer reading = 1010.50 mbar * 0.01 / 0.689476 = 14.66 psia
Enter offset in Convert Hex’s Coefficient Configuration dialog box.

Offset = 14.66 — 14.06 = +0.60 psia
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Calculating Slope and Offset using a Dead-Weight Pressure Generator

Tests show that room-temperature-derived slope and offset corrections to the
initial quartz calibration can account for long-term drift to within less than
0.01% of the sensor’s full scale range. To perform this correction:

1. Use a suitable dead-weight pressure generator to subject the sensor to
increments of known pressures. The end cap’s 5/16-24 straight thread
permits mechanical connection to a pressure source. Use a fitting
that has an o-ring face seal, such as Swagelok-200-1-OR.

See Application Note 12-1: Pressure Port Oil Refill Procedure & Nylon
Capillary Fitting Replacement.

2. In SeatermW, connect to the SBE 26.

3. Send FR to display the pressure and pressure sensor temperature
compensation frequencies. Click stop to end the test.

4. Compute pressure from the frequencies with the formula shown on the
calibration sheet.

5. Enter the calculated slope and offset (positive or negative) in Convert
Hex’s Coefficient Configuration dialog box.

Pressure Slope and Offset Correction Example
A 45 psia sensor has drifted and its responses are low, as shown below:

Actual Pressure (psia) Indicated Pressure (psia)
0.000 -0.057
9.000 8.939
18.000 17.936
27.000 26.932
36.000 35.929
45.000 44.925

Linear regression (best straight-line fit) pcorrected = (pindicated * slope) + offset
yields slope = 1.00039381 and offset = 0.057. Enter these correction coefficients, originally set to
1.0 and 0.0 respectively, in Convert Hex’s Coefficient Configuration dialog box.

Temperature Sensor Calibration

The primary source of temperature sensor calibration drift is the aging of the
thermistor element. Sensor drift is usually a few thousandths of a degree
during the first year, and less in subsequent intervals. Sensor drift is not
substantially dependent upon the environmental conditions of use, and —
unlike platinum or copper elements — the thermistor is insensitive

to shock.

The temperature sensor calibration certificate shows the following coefficients:

e Al and XI are hard coded in the SBE 26 EPROM and are used to
calculate the raw hex data (Note that some temperature sensor calibration
sheets list g and x instead of Al and XI. Verify that g = Al and x = XL.).
View these coefficients with DC in SeatermW.

e Zand RH are used internally only.

e A0, Al, and A3 are used in Convert Hex to convert the raw temperature
data to engineering units. View and/or modify these coefficients in
Convert Hex’s Coefficient Configuration dialog box.
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Conductivity Sensor Calibration

The optional SBE 4M conductivity sensor incorporates a fixed precision
resistor in parallel with the cell. When the cell is dry and in air, the sensor’s
electrical circuitry outputs a frequency representative of the fixed resistor. This
frequency is recorded on the Calibration Certificate and should remain stable
(within 1 Hz) over time.

The conductivity sensor calibration certificate shows the following coefficients:
g, h, 1, j, Cpcor, and Ctcor. View and/or modify these coefficients in Convert
Hex’s Coefficient Configuration dialog box.

e  Cpcor makes a correction for the highly consistent change in dimensions
of the conductivity cell under pressure. The default is the compressibility
coefficient for borosilicate glass (-9.57¢-08). Some sensors fabricated
between 1992 and 1995 (serial numbers between 1100 and 1500) exhibit a
compression that is slightly less than pure borosilicate glass. For these
sensors, the (hermetic) epoxy jacket on the glass cell is unintentionally
strong, creating a composite pressure effect of borosilicate and epoxy.

For sensors tested to date, this composite pressure coefficient ranges from
-9.57¢-08 to -6.90e-08, with the latter value producing a correction to
deep ocean salinity of 0.0057 PSU in 5000 dbars pressure (approximately
0.001 PSU per 1000 dbars). Before modifying Cpcor, confirm that the
sensor behaves differently from pure borosilicate glass. Sea-Bird can test
your cell and calculate Cpcor. Alternatively, test the cell by comparing
computed salinity to the salinity of water samples from a range of depths,
calculated using an AutoSal.

Enter values for slope (default = 1.0) and offset (default = 0.0) in Convert
Hex’s Coefficient Configuration dialog box to make small corrections for

conductivity sensor drift between calibrations:

Note: Corrected conductivity = (slope * computed conductivity) + offset
See Application Note 31 for where
computation of slope and offset slope = true conductivity span / instrument conductivity span

correction coefficients from pre-

. Lo offset = (true conductivity — instrument reading) * slope; measured at 0 S/m
and post-cruise calibrations

supplied by Sea-Bird or from . .
salinity bottle samples taken at Conductivity Slope and Offset Correction Example

sea during profiling. At true conductivity = 0.0 S/m, instrument reading = -0.00007 S/m
At true conductivity = 3.5 S/m, instrument reading = 3.49965 S/m

Calculating the slope and offset:
Slope = (3.5 - 0.0) / (3.49965 - [- 0.00007]) =+ 1.000080006
Offset = (0.0 - [-0.00007]) * 1.000080006 = + 0.000070006

The primary mechanism for calibration drift in conductivity sensors is the
fouling of the cell by chemical or biological deposits. Fouling changes the cell
geometry, resulting in a shift in cell constant (slope of the calibration curve),
typically resulting in lower conductivity readings over time. Offset error
(error at 0 S/m) is usually due to electronics drift, and is typically less than
+0.0001 S/m per year. Because offsets greater than + 0.0002 S/m are a
symptom of sensor malfunction, Sea-Bird recommends that drift corrections
be made by assuming no offset error, unless there is strong evidence to the
contrary or a special need.

The most important determinant of long-term sensor accuracy is the
cleanliness of the cell. We recommend that the conductivity sensors be
calibrated before and after deployment, but particularly when the cell has been
exposed to contamination by oil slicks or biological material.
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Section 11: Troubleshooting

This section reviews common problems in operating the SBE 26, and provides
the most common causes and solutions.

Problem 1: Unable to Communicate with SBE 26

Note:

Using the reset switch erases the
SBE 26 memory — all logged data
in memory is lost and all user-
programmable parameters (date and
time, sampling scheme, etc.) are
reset to default values.

The S> prompt indicates that communications between the SBE 26 and
computer have been established. Before proceeding with troubleshooting,
attempt to establish communications again by clicking Connect in SeatermW
or hitting the Enter key several times.

Cause/Solution 1: The I/O cable connection may be loose. Check the cabling
between the SBE 26 and computer for a loose connection.

Cause/Solution 2: The instrument and/or Comm port may not have been
entered correctly in SeatermW. Click Configure and verify the settings.

Cause/Solution 3: The 1/0O cable may not be the correct one. The I/O cable
supplied with the SBE 26 permits connection to the DB-9P input connector on
a standard RS-232 interface.

e SBE 26 Pin 1 (large pin) goes to DB-9 pin 5 (ground)

e SBE 26 pin 2 (counter-clockwise from large pin) goes to DB-9 pin 3

e SBE 26 pin 3 (opposite the large pin) goes to DB-9 pin 2

Cause/Solution 4: If attempting to communicate with the SBE 26 after you
started logging, the SBE 26 may be collecting a wave burst (indicated by
sequences of a’s and d’s on the display). You cannot communicate with the
SBE 26 while it is collecting a wave burst. Try to establish communications
again a few seconds after the characters stop.

Cause/Solution 5: In rare cases, the program that controls the SBE 26’s

microprocessor can be corrupted by a severe static shock or other problem.

This program can be initialized by using the reset switch. Proceed as follows

to initialize:

1. Open the battery end cap and remove the batteries (see Battery
Replacement in Section 10: Routine Maintenance and Calibration).

2. There is a toggle reset switch on the battery compartment bulkhead, which

is visible after the batteries are removed. The switch is used to disconnect

the internal lithium batteries from the electronics. Set the switch to the

reset position for at least 5 minutes.

Reinstall or replace the batteries, and close the battery end cap.

4. Establish communications with the SBE 26 (see Section 5: SBE 26 Setup,
Installation, and Data Upload - SeatermW for details). Initialize RAM
(IR), reset the date and time (ST), and re-enter all the setup parameters.

W
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Problem 2: Nonsense or Unreasonable Data

The symptom of this problem is an uploaded file that contains unreasonable
values (for example, values that are outside the expected range of the data).

Cause/Solution 1: An uploaded data file with unreasonable values for
pressure, temperature, or conductivity may be caused by incorrect calibration
coefficients in the instrument .ini file (each SBE 26 is shipped with a .ini file).
View the coefficients by clicking the Coefficients button in Convert Hex.
Verify that the calibration coefficients in the instrument .ini file match the
instrument Calibration Certificates.
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Glossary

Battery and Memory Endurance — SEASOFT for Waves module for
calculating power endurance and memory endurance for a user-specified
sampling scheme.

Convert Hex — SEASOFT for Waves module for converting uploaded .hex
file into separate wave (.wb) and tide (.tid) files.

Create Reports — SEASOFT for Waves module for outputting one line of
surface wave time series and/or wave burst auto-spectrum statistics for each
processed wave burst.

Fouling — Biological growth in the conductivity cell during deployment.

Merge Barometric Pressure — SEASOFT for Waves module for removing
barometric pressure from tide data.

PCB - Printed Circuit Board.

Plan Deployment — SEASOFT for Waves module for calculating the ratio of
pressure amplitude measured by the instrument to pressure amplitude at the
surface, and predicting number of frequency bands calculated, width of each
band, and frequency span.

Plot Data — SEASOFT for Waves module for plotting wave and tide data.

Process Wave Burst Data— SEASOFT for Waves module for computing
wave statistics.

SEAGAUGE — High-accuracy wave and tide recorder with a quartz pressure
sensor, precision thermometer, and optional SBE 4M conductivity sensor.

SEASOFT for Waves - DOS — Modular DOS program for use with the
SBE 26.

SEASOFT for Waves — Modular Win 95/98/NT/2000/XP program for pre-
deployment planning, communication with the SBE 26 for setup, uploading of
data from the SBE 26, separation of the raw data into separate wave and tide
files, removal of barometric pressure from tide data, statistical analysis, and data
plotting. Modules include Plan Deployment, Battery and Memory Endurance,
SeatermW, Convert Hex, Merge Barometric Pressure, Process Wave Burst Data,
Create Reports, and Plot Data.

SeatermW — SEASOFT for Waves module for communication with the
SBE 26 for setup and uploading of data from the SBE 26.

TCXO — Temperature Compensated Crystal Oscillator.

Triton X-100 — Reagent grade non-ionic surfactant (detergent), used for
cleaning the conductivity cell. Triton can be ordered from Sea-Bird,

but should also be available locally from chemical supply or laboratory
products companies. Triton is manufactured by Mallinckrodt Baker

(see http://www.mallbaker.com/changecountry.asp?back=/Default.asp
for local distributors).
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Appendix I: Command Summary

Note:

Commands followed by * alter
SBE 26 memory and prompt the
user twice before executing (* is
not part of the command). To
execute the command, type Y
and press Enter key in response
to message Y/N. Then hold
down Ctrl key and type y, and
press Enter key in response to
are you sure “Y/N. Any other
responses abort the command.

CATEGORY

COMMAND

DESCRIPTION

Status

DS

Display status and setup parameters.

DC

Display pressure sensor and temperature sensor
calibration coefficients that are hard coded into
SBE 26 EPROM.

Setup

IR *

Initialize memory, which destroys all logged
data in memory.

ST

Set real-time clock date and time.

SI

Set sampling intervals and parameters:

o Tide interval

o Wave burst after every N tide measurements

o Wave samples/burst — for most accurate
results, this number should be a power of 2
(2,4,8, 16,32, 64, 128, etc.)

e Number of 0.25-second periods to
integrate waves

Cx

X=Y: Enable conductivity logging (use if
optional SBE 4M conductivity sensor included).
X=N: Do not.

LWx

X= wait interval (milliseconds) after each line of
data. Normally set to 0; increase for very slow
computers. Range 0 — 65535.

QS

Enter quiescent (sleep) state. Main power turned
off, but memory retention unaffected.

Logging

GL *

Start logging, overwriting any logged data
in memory.

Quit logging.

Data Upload

DDb,e

Display raw data from memory in Hex from
sample b to e at 9600 baud.

DEb,e

Display raw data from memory in Hex from
sample b to e at 19200 baud.

DAb,e

Display raw data from memory in Hex from
sample b to e at 38400 baud.

Diagnostic

Memory test, which destroys all data
in memory.

Extended memory test, which destroys all data
in memory.

FR

Measure and display pressure frequency,
pressure temperature compensation frequency,
and conductivity sensor frequency. SBE 26 runs
continuously during test, drawing current. Press
Esc key or Stop to stop test.

VR

Measure and display (main battery
voltage/5.0161), (lithium battery voltage/3.873),
raw thermistor voltage, raw large reference
resistor voltage, and raw small reference resistor
voltage. SBE 26 runs continuously during test,
drawing current. Press Esc key or Stop to

stop test.
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Appendix Il: Sample Timing

Note the following, as illustrated in the example below:

e  When GL is sent to start logging, the SBE 26 sleeps for one tide interval
before starting logging.

e The SBE 26 integrates the pressure sensor output over the entire tide
interval, calculating and storing an average pressure for that time period.

e Actual calculation and storing of tide data is delayed by two tide intervals.
For example, as the SBE 26 begins tide measurement #3, it is
simultaneously calculating and storing the data from tide measurement #1.

e  Wave burst sampling is done after the calculation and storing of the
applicable measurement. For example, if the SBE 26 is set up to sample a
wave burst after every four tide measurements, the first wave burst occurs
after the calculation and storing of data from tide #4.

e  Time required for each wave burst must be less than
(tide interval - 30 seconds). If the user setup does not meet this requirement,
the SBE 26 reduces the number of measurements in the wave burst to meet
the requirement.

Example:

Tide interval = 60 minutes.

Wave burst of 128 measurements at 0.5 seconds/measurement (128 x 0.5 = 64 seconds) after ever 4 tide measurements.
User sends GL at 12 pm.

. Begin Tide Measurement Begin to Calculate and Store Data Begin Wave Burst

Time .

# from Tide Measurement # #
12:00 (user sends GL)
13:00 #1 - -
14:00 #2 - -
15:00 #3 #1 -
16:00 #4 #2 -
17:00 #5 #3 -
18:00 #6 #4 -
19:00 #71 #5 #1
20:00 #8 #6 -
21:00 #9 #7 -
22:00 #10 #8 -
23:00 #11 #9 #2
00:00 #12 #10 -
01:00 #13 #11 -
02:00 #14 #12 -
03:00 #15 #13 #3
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Notes:

e See Section 7: Tide Data
Processing — Merge
Barometric Pressure for the
barometric pressure file
(.bp) format.

e The format for the .wss file,
created if Output FFT
coefficients to .wss file is
selected in Process Wave
Burst Data, is not detailed.

This appendix provides detailed information on data format for each file type.

Extension Description

.hex Raw Hex data uploaded from SBE 26 memory using SeatermW.

Tide measurements only, created from .hex file by Convert Hex. Also,
.tid file output by Merge Barometric Pressure, which removes barometric
pressure from an input .tid file.

b Barometric pressure data, used by Merge Barometric Pressure to
-op remove barometric pressure from the tide data (.tid) file.

.wb Wave measurements only, created from .hex file by Convert Hex.

Statistics and results from auto-spectrum analysis, created by Process

Was Wave Burst Data.

.rpt Summary report, created by Process Wave Burst Data.

Fast Fourier Transform coefficients, created by Process Wave Burst

WSS data if selected.
Statistics from surface wave zero crossing analysis, created by Process
.wits
Wave Burst Data.
wt Surface wave time series, created by Process Wave Burst Data

if Output surface wave time series to .wt file is selected.

File containing one line of surface wave time series and/or wave burst
.r26 auto-spectrum statistics for each processed wave burst, created by
Create Reports.

Hex Data Format (.hex extension)

A .hex file contains raw hexadecimal data uploaded from SBE 26 memory
using SeatermW’ Upload. The beginning of a sample .hex data file follows:

* Sea-Bird SBE 26 Data File:
* FileName = 23.HEX
* Software Version 4.0.b.20

*ds
*SBE 26 SEAGAUGE V4.1d SN 335, 06/06/02 13:09:14.439
*pressure sensor: serial number = 36285, range = 45 psi

*clk = 32767.843 iop = 63 vmain = 13.1 vliith = 5.9
*last sample: p = 13.3193 t = 1.407

*

*tide measurement interval = 5 min

*measure waves after every 1 tide samples
*1024 wave samples/burst at 4.00 scans/second
*

*tide samples/day = 288.000

*wave bursts/day = 288.000

*memory endurance = 0.052 days

*recorded tide measurements = 27

*recorded wave bursts = 27

*

*conductivity = YES

*logdata = NO

*dc

*Paroscientific Digiquartz calibration coefficients:
* U0 = 5.881116

* Yl = -3971.433

* Y2 = -9778.307

* Y3 = 0.000

* Cl = 170.09370

*

C2 = 22.880490
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* C3 = =-230.10930
* D1 = 0.0589810
* D2 = 0.0000000
* Tl = 24.31375
* T2 = 0.5175830
* T3 = 17.76489
* T4 = 0.00000

* T5 = 0.00000

* M = 9532.5

* B = 4766.3

*

*Temperature coefficients:

* Z = -49405.0

* RH = 46995.0

* AT = 268135.0

* XI = -8.879

*S>

FFFFFFFD (flag beginning of tide parameters)
04C6B570 (time of beginning of first tide sample)
012C0001 (tide integration period, wave integration period)
FFFFFFFE (flag end of tide parameters)

5ED8C726 (tide data — pressure and temperature)
000ACF6B (conductivity data, only present if enabled)
00000000 (flag beginning of wave burst)

04C6B7C8 (wave burst time)

A7578200 (pressure temperature compensation frequency)
9A12CB9A (wave burst pressure data)

12C89A12 ("

CB9A12CB ("

9A12C89A "M

12CB9A12 ("

CB9A12C8 ")

FFFFFFFF (flag end of wave burst)

5ED8C726 (tide data)

000ACF6B (conductivity data, only present if enabled)

e Beginning lines - * flags header. Header lines contain (in order):
» Input file name
» Software version used to upload the data
» SBE 26 response to display status (DS) command
» SBE 26 response to display calibration coefficients (DC) command

e Following lines - Data follows, with eight characters per line, followed by
a carriage return and line feed. Data is described below.

Tide Parameters and Data
Data (lines after the *S>) is described below:

e First line - FFFFFFFD; flags the start of tide parameters.

e Second line - Start time (seconds since January 1, 1989) of integration of
first tide sample.

e  Third line - First four characters is tide sample interval (seconds);
last four characters is number of 0.25-second periods to integrate
wave samples.

e Fourth line - FFFFFFFE; flags the end of tide parameters.

o  Fifth and following lines — Fifth line is a tide record (pressure and
temperature). For tide record, first 19 bits are pressure number and last
13 bits are temperature voltage. If conductivity logging is enabled (CY), a
tide record is followed by a conductivity record.
All lines that are not flags, tide parameters, or wave burst data are tide
(pressure and temperature) or conductivity records.
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Convert Hex converts the raw hex data to pressure, temperature, and
(optional) conductivity in engineering units when the data is separated into
tide and wave burst files. The tide data conversions are described below:

Tide Record (pressure and temperature)

pressure = [ slope correction * (pressure number - B) / M ] + offset correction

where

e slope and offset corrections are read from the Convert Hex calibration
coefficients (.ini) file.

e M and B are scaling parameters that depend on pressure sensor range, and

are stored in EPROM:
Pressure Sensor Range (psia) M B
23 21845 0
30 15887.5 7943.8
45 9532.5 4766.3
100 4766.3 2383.2
200 2383.1 1191.6
300 1588.8 794.4
400 1191.6 595.8
1000 476.6 238.3
2000 238.3 119.2
3000 158.9 79.5
6000 79.4 39.7
10000 47.7 23.9

temperature voltage = (temperature number - 4095) / 819
Temperature is computed as follows:

LR =In ( [AI/ (temperature voltage - XI) ] - 15000.0)

Note:
Some temperature sensor

calibration sheets list g instead of

Al and x instead of XI.

temperature =[ 1.0 / (A0 + Al * LR + A3 * LR?) ] - 273.15

where

e Al and XI are hard coded in the SBE 26 EPROM and are read from the
.hex file header.

e A0, Al, and A3 are read from the Convert Hex calibration coefficients
(.ini) file.

Example: tide record = 49E6A726 hex = 0100 1001 11100110 1010 0111 0010 0110 binary

The first 19 bits are 0100100111100110101 binary = decimal 151349.
For this example, assume 45 psia pressure sensor, slope correction = 1.0, and offset correction = 0.
pressure = [ slope correction * (151349 — 4766.3) / 9532.5 ] + offset correction = 15.3772 psia

The last 13 bits are 0011100100110 binary = decimal 1830.

temperature voltage = (1830 - 4095) / 819 = -2.766 volts

For this example, assume AQ = 1.0e-3, Al =2.3e-4, A3 = 1.5¢-7, XI = -8.745, and Al = 271800.

LR =1n ( [271800 / (-2.766 - -8.745) ] - 15000.0) = 10.32414

temperature = [1.0 / ( 1.0e-3 + 2.3e-4 * 10.32414 + 1.5¢-7 * 10.32414 %) ] - 273.15
=[1.0/3.5396¢-3] - 273.15 =9.366 °C

Conductivity Record
conductivity frequency (Hz) = conductivity number / 256
Conductivity frequency is converted to conductivity using the coefficients and

equation found on the calibration certificate for the sensor. These coefficients are
read from the Convert Hex calibration coefficients (.ini) file.

Example:
Conductivity number = 000ACF6B hex =708459 decimal
Conductivity frequency = 708459 /256 = 2767.418 Hz
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Wave Burst Data

e  First wave burst line = 00000000; flags the start of a wave burst.

e Second wave burst line = Start time (seconds since January 1, 1989) of
wave burst.

e  Third wave burst line = First 24 bits is pressure temperature
compensation frequency; last 8 bits are 0.

e Fourth and following wave burst lines = Next n groups of 24 bits are
pressure frequencies, where n is number of wave samples per burst.

e Last wave burst line = FFFFFFFF; flags the end of a wave burst.
Convert Hex automatically makes the conversion of the raw hex data to
pressure when the data is separated into tide and wave burst files. The
conversions are described below:

Pressure temperature compensation frequency = PTCF = 24 bits / 64

Pressure frequency = PF = 24 bits / 256
Pressure period=T =1/PF

Pressure is computed as follows:

U=[(1.0/PTCF) * 1000000 ] - UO
(note that U0 may be listed as X0 on the calibration sheet)

C=Cl+(C2*U)+(C3*U?
D=DI1+D2 butD2=0,s0 D=DI

TO=(T1+T2* U+ T3 *U?+ T4 * U+ T5 * U*) /1000000 But T5=0, so
TO=(T1+T2* U+ T3 * U+ T4 * U*) / 1000000

W=1.0-(TO*TO/T*T)
pressure = slope correction * [ C * W * (1.0 - D * W) ] + offset correction

where

e U0, Cl1,C2,C3,D1,T1, T2, T3, and T4 are hard coded in the SBE 26
EPROM and are read from the uploaded .hex file header.

e Slope and offset corrections are read from the Convert Hex calibration
coefficients (.ini) file.
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Tide Data Format (.tid extension)

Note:

If conductivity logging is not
enabled (conductivity = NO in the
status display), the sixth and
seventh columns are not included
in the .tid file.

A .tid file is created from the .hex file in Convert Hex. A sample tide data
(.tid) file is shown below:

1 11/13/92 10:27:16  14.8125 22.102  3.55682 23.909
2 11/13/92 10:28:16  15.0086 14.818  3.48032 27.844
3 11/13/92 10:29:16  15.0836 11.242  3.07901 26.714
4 11/13/92 10:30:16  15.1536 8.951  3.07101 28.376
5 11/13/92 10:31:16  15.2267 7.225  3.06788 29.772
e Column 1 = Tide measurement number

e Columns 2 and 3 = Date and time of beginning of tide measurement
e  Column 4 = Measured pressure in psia

e Column 5 = Measured water temperature in °C

e  Column 6= Measured conductivity in S/m

e Column 7 = Calculated salinity in PSU

If Merge Barometric Pressure has been run on the .tid file to remove the effect
of barometric pressure, the output .tid file contains descriptive column
headings. The presence of headings in the .tid file indicates that it has been
processed by Merge Barometric Pressure. Additionally, Merge Barometric
Pressure has the ability to replace the pressure in the fourth column with
calculated water depth. See Section 7: Tide Data Processing — Merge
Barometric Pressure for details, and for the required data format for the
barometric pressure (.bp) file to input in Merge Barometric Pressure.

Wave Burst Data Format (.wb extension)

A .wb file is created from the .hex file in Convert Hex. A sample wave burst
data file is shown below:

* 0 39714178 1.00 32

21.344801 21.344801 21.250858 21.058917
20.948967 20.986165 21.101858 21.188864
21.204989 21.157996 21.094862 21.030808
21.030145 21.133848 21.241456 21.250286
21.139034 21.006829 20.983782 21.064104
21.176656 21.267824 21.261526 21.168517
21.102853 21.075775 21.035574 21.002877
21.046280 21.145214 21.204416 21.199654
* 1 39724978 1.00 32
22.135044 22.135044 22.203410 22.258581
22.272837 22.277849 22.284841 22.250777
22.173778 22.123603 22.151409 22.223522
22.288892 22.341974 22.368526 22.333153
22.246305 22.182725 22.175729 22.182845
22.194884 22.236219 22.252728 22.185787
22.119699 22.198516 22.385685 22.516203
22.506578 22.397684 22.269475 22.156724

e  First line - * flags beginning of data for a wave burst. Line contains
(in order):

Wave burst number

Start of tide measurement (seconds since January 1, 1989)

Wave integration period (seconds)

Number of points in wave burst

YV VY

e Second and following lines (until next line with *) -
Measured pressures in psia, with four values per line
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Wave Burst Auto-Spectrum Statistics (.was extension)

A .was file is created from the .wb file in Process Wave Burst Data. A sample
wave burst Auto-Spectrum statistics file is shown below:

* 0 39714178 1.00 1024 10 5.666 4.466 1024.211 90 0.637 1.843
51 5.371094e-003 9.765625e-003 5.9946e-003 6.0210e+001 1.0732e+001 3.0970e-001
3.091334e-003 3.298001e-003 2.160857e-003 7.776975e-004
5.304750e-003 3.731420e-003 1.790720e-002 2.439886e-002
8.326155e-002 1.082657e-001 5.056803e-002 5.299359e-002
2.502890e-002 2.332787e-002 2.122386e-002 1.846813e-002
3.559706e-002 3.633030e-002 2.943071e-002 8.796323e-003
8.000838e-003 4.111465e-003 2.995502e-003 6.887020e-003
2.995481e-003 4.263404e-003 1.317504e-003 3.054346e-003
1.688730e-003 2.141096e-003 1.688405e-003 3.960159e-003
1.314685e-003 1.714741e-003 1.393692e-003 1.332473e-003
3.300501e-004 5.239898e-004 3.741254e-004 1.336304e-003
5.561366e-004 6.184441e-004 8.887792e-004 4.510226e-004
5.383913e-004 4.866397e-004 1.003825e-003 5.819744e-004
7.742675e-004 1.622945e-003 9.336277e-004

* 1 39724978 1.00 1024 10 6.378 5.178 1024.211 90 0.637 1.843
51 5.371094e-003 9.765625e-003 6.2661e-003 6.2937e+001 1.0732e+001 3.1663e-001
2.399138e-003 4.958530e-003 5.970532e-003 5.397915e-003
3.676770e-003 2.406614e-002 1.292470e-002 2.224974e-002
4.823480e-002 1.086449e-001 7.481066e-002 8.684431e-002
1.948858e-002 2.912741e-002 3.741619e-002 2.336472e-002
2.254591e-002 1.218159e-002 1.780615e-002 4.395502e-003
9.833613e-003 3.936535e-003 5.881464e-003 4.571996e-003
5.443738e-003 4.163474e-003 3.601095e-003 3.585647e-003
5.531514e-003 1.835893e-003 1.114426e-003 3.934834e-003
2.174772e-003 1.469032e-003 1.335585e-003 9.147523e-004
6.760068e-004 8.808380e-004 5.716856e-004 7.181183e-004
6.005655e-004 4.775679e-004 1.299268e-003 3.855911e-004
4.464863e-004 4.614029e-004 6.163178e-004 8.327592e-004
1.575676e-003 1.628755e-003 4.645250e-003

e  First line - * flags the beginning of the data for a wave burst. Line
contains (in order):

Wave burst number

Start of wave burst (seconds since January 1, 1989)

Wave integration time (seconds)

Number of points in the wave burst

VVVVVVVVVYY

Number of spectral estimates for each frequency band
Water depth (meters)

Pressure sensor depth (meters)
Density (kg/m’)
Chi-squared confidence interval (percent)
Multiplier for Chi-squared lower bound
Multiplier for Chi-squared upper bound

Second line contains (in order):
Number of frequency bands calculated
Frequency of first frequency band (Hz)
Interval between frequency bands (delta f) (Hz)

Total variance (meters®)

Total energy (Joules / meters®)

Significant period (seconds) = frequency band with greatest variance
Significant wave height (meters) = 4 x sqrt (total variance)

VVVYVYVVY

e  Third and following lines (until next line with *) -
Values (beginning with the first frequency) for the Auto-Spectral density
function <Gaa>. Units are meters” / Hz. To obtain the variance (m?) in a
frequency interval &f (Hz), multiply the value of <Gaa> by 6f.
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Wave Burst Auto-Spectrum Report (.rpt extension)

A .rpt file is created from the .wb file in Process Wave Burst Data. A sample
wave burst Auto-Spectrum report file is shown below:

surface wave processing summary:
file = aprl2sp.wb

temperature = 15.000

salinity = 33.000

density = 1024.431

numpber of points per wave burst = 1028
sample period = 1.00 sec
burst # 1:

mean pressure = 21.207 psia

instrument depth = 4.466 meters

total water depth = 5.666 meters
auto-spectrum:

10 spectral estimates per band

51 bands calculated

each band is 0.010 Hz wide

frequency span = 0.005 to 0.492 Hz

MM/DD HH:MM SIG.HT SIG.PER ENERGY (CM.SQ.)
(CM) (SEC) 22+ 20 17 15 13 11 9 7 5 3

04/05 15:42 31 11 2 19 13 10 10 3

04/05 18:42 32 11 1 15 18 11 7 4

04/05 21:42 46 3 2 7 12 15 8 82

04/06 00:42 39 9 2 10 13 14 8 39
6

04/06 03:42 41 18
04/06 06:42 45 10
04/06 09:42 49 8
04/06 12:42 57 16
04/06 15:42 61 16
04/06 18:42 67 16

41
10 21 12 13 56
13 23 27 29 42
6 28 17 43 71
9 27 18 60 50
9 17 12 52 70

AR RN WRE NN
=
NOONNNWWN N O
[eNeNeNoNeoNeoNoNoNoNel
e}

LW NWN U WNN
o
[
|
[

[

0

~J
N
w

The energy (centimeters squared) is the sum of the variance over the indicated
frequency band:

e The 9 second wave period column is the sum of the variances where the
frequency is between 1/10 Hz and 1/8 Hz.

e  The 20 second wave period column is the sum of the variances where the
frequency is between 1/22 Hz and 1/18 Hz.

e  The 22+ second wave period is the sum of the variances of all the frequencies
less than 1/22 Hz.

Significant period = 1 / (band averaged frequency with the greatest variance)
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Surface Wave Time Series Statistics (.wts extension)

A .wits file is created from the .wb file in Process Wave Burst Data. A sample
surface wave time series statistics file is shown below:

* 0 39714178 1.00 1024 109 5.666 4.466 1024.431
6.860774e-003 6.892497e+001 1.972292e-001 7.431193e+000
6.293907e-001 3.115848e-001 9.138889e+000 4.114119e-001 6.293907e-001
* 1 39724978 1.00 1024 112 6.377 5.177 1024.431
6.632170e-003 6.662836e+001 1.914052e-001 7.223214e+000
3

4.505061e-001

.078597e-001 9.000000e+000

.902955e-001 4.505061e-001

e  First line - * flags the beginning of the data for a wave burst. Line
contains (in order):

Wave burst number

Start of wave burst (seconds since January 1, 1989)

Wave integration time (seconds)

Number of points in the wave burst

Number of individual waves found

Water depth (meters)

Pressure sensor depth (meters)

Density (kg/m’)

VVVVVVYYVY

e Second line contains (in order):

Total variance of time series (meters?)

Total energy of time series (Joules / meters?)
Average wave height (meters)

Average wave period (seconds)

VVVYVYY

e  Third line contains (in order):

Maximum wave height (meters)

Significant wave height (meters) [average height of largest

1/3 waves]

Significant period (seconds) [average period of largest 1/3 waves]
Hj10 (meters) [average height of largest 1/10 waves] -

If less than 10 waves, Hy, o is set to 0

Hj/ 100 (meters) [average height of largest 1/100 waves] -

If less than 100 waves, Hy/ ¢ is set to 0

YV VV VYV
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Surface Wave Time Series (.wt extension)

A .wt file is created from the .wb file in Process Wave Burst Data, if Output
surface wave time series to .wt file is selected. Part of a sample surface wave
time series file is shown below:

* 0 39714178 1.00 32

-0.1783 -0.2180 -0.1793 -0.0721
0.0615 0.1677 0.2036 0.1582
0.0521 -0.0754 -0.1829 -0.2384

e  First line - * flags the beginning of the data for a wave burst. Line
contains (in order):
» Wave burst number
»  Start of tide measurement (seconds since January 1, 1989)
» Wave integration period (seconds)
» Number of points in wave burst

e Second and following lines (until the next line with *) -
Measured wave amplitudes in meters, with four values per line.

Wave Burst Statistics Report (.r26 extension)

HH = H H

Burst Time-jdays
Maxheight H1/10
0 232.67205
3.384997e+00 1.441726e+00
1 232.75538
8.741022e-01 7.083250e-01

A 126 file is created from the .was and .wts file in Create Reports. Part of a
sample report file is shown below:

filename = D:\SBE26\951002[.WAS, .WTS]

wave integration time =

number of points in the burst

= 1024

height of SBE 26 above the bottom = 0.300

density = 1024.153

8.741022e-01

Time-hours Depth Nwaves Avgheight Avgper
H1/100 Swp-wts Swh-wts
0.000 17.759 211 4.600717e-01 3.838863e+00
3.134322e+00 4.200000e+00 8.141103e-01
2.000 17.679 185 2.278769e-01 4.383784e+00

6.344262e+00 5.092874e-01

e Beginning lines - # flags header. Header lines contain (in order):
Input file name

Wave integration period (seconds)

Number of points in the wave burst

Height of pressure sensor above bottom

Water density

VVYVYVYV

e  Column heading line and data —
Data varies, depending on user-selected variables to be output.
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Appendix IV: Electronics
Disassembly/Reassembly

Note:

Disassembling the electronics
erases the SBE 26 memory — all
logged data in memory is lost and all
user-programmable parameters (date
and time, sampling scheme, etc.) are
reset to default values.

Jackscrew
kit

Sea-Bird provides a jackscrew kit with the SBE 26, to assist in removal of the
connector end cap. The kit contains:

e 2 Allen wrenches

e 3 jackscrews

e 2 spare plastic socket hex-head screws

Disassembly

CAUTION:

Disconnect and dismount the optional
SBE 4M conductivity cell from the
SBE 26 before disassembly to avoid
breaking the conductivity cell.

Plastic hex-head screw
(typical, 3 places)

Titanium hex-head screw
(typical, 4 places)

1. Establish communications with the SBE 26 (see Section 5: SBE 26 Setup,
Installation, and Data Upload - SeatermW for details). As a precaution,
click Upload to upload any data in memory before beginning.

2. Wipe the outside of the end cap and housing dry, being careful to remove
any water at the seam between them.

3. Remove the four titanium hex-head screws securing the connector end cap
to the housing.

4. Remove the three plastic hex-head screws from the end cap using the
larger Allen wrench. Insert the three jackscrews in these three holes in the
end cap. When you begin to feel resistance, use the smaller Allen wrench
to continue turning the screws. Turn each screw 1/2 turn at a time. As you
turn the jackscrews, the end cap will push away from the housing. When
the end cap is loosened, pull it and the PCB assembly out of the housing.

5. Remove any water from the O-ring mating surfaces inside the housing
with a lint-free cloth or tissue. Be careful to protect the O-rings from

damage or contamination.

6. Disconnect the Molex connector connecting the PCB assembly to
the battery compartment bulkhead.

7. Remove the jackscrews from the end cap.
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Reassembly

1. Remove any water from the O-ring and mating surfaces with a lint-free

Note: cloth or tissue. Inspect the O-ring and mating surfaces for dirt, nicks, and
Before delivery, a desiccant package cuts. Clean or replace as necessary. Apply a light coat of O-ring lubricant
is inserted in the housing and the (Parker Super O Lube) to O-ring and mating surfaces.

electronics chamber is filled with dry

Argon gas. These measures help 2. Reconnect the Molex connector to the PCB assembly. Verify the

prevent condensation. To ensure
proper functioning:
1. Install a new desiccant bag each

connector holds and pins are properly aligned.

time you open the electronics 3. Carefully fit the PCB assembly into the housing, aligning the holes in the
chamber. If a new bag is not end cap and housing.
available, see Application
Note 71: Desiccant Use and 4. Reinstall the 4 hex-head screws to secure the end cap to the housing.
Regeneration (drying).

2. If possible, dry gas backfill each 5. Reinstall the 3 plastic hex head screws in the end cap.

time you open the housing. If you

cannot, wait at least 24 hours . L. . . .
before redeploying, to allow the 6. Establish communications with the SBE 26 (see Section 5: SBE 26 Setup,

desiccant to remove any moisture Installation, and Data Upload - SeatermW for details). Initialize RAM
from the housing. (IR), reset the date and time (ST), and re-enter all the setup parameters.
Note that opening the battery

compartment does not affect
desiccation of the electronics.
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Appendix V: AF24173 Anti-Foulant Device

AF24173 Anti-Foulant Devices supplied for user replacement are supplied in
polyethylene bags displaying the following label:

AF24173 ANTI-FOULANT DEVICE

FOR USE ONLY IN SEA-BIRD ELECTRONICS' CONDUCTIVITY SENSORS TO CONTROL THE GROWTH OF AQUATIC ORGANISMS
WITHIN ELECTRONIC CONDUCTIVITY SENSORS.

ACTIVE INGREDIENT:

Bis(tributyltin) oxide..........ccooiiiiiiiiiiii e 53.0%
OTHER INGREDIENTS: ... 47.0%
TOtAl. e 100.0%
DANGER

See the complete label within the Conductivity Instrument Manual for Additional Precautionary Statements and Information on the Handling, Storage, and
Disposal of this Product.

Net Contents: Two anti-foulant devices

Sea-Bird Electronics, Inc. EPA Registration No. 74489-1

1808 - 136" Place Northeast EPA Establishment No. 74489-WA-1
Bellevue, WA 98005
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Appendix V: AF24173 Anti-Foulant Devices

AF24173 Anti-Foulant Device

FOR USE ONLY IN SEA-BIRD ELECTRONICS” CONDUCTIVITY SENSORS TO CONTROL
THE GROWTH OF AQUATIC ORGANISMS WITHIN ELECTRONIC CONDUCTIVITY
SENSORS.

ACTIVE INGREDIENT:

Bis(tributyltin) oxide...........ooooeiiiiiiii 53.0%
OTHER INGREDIENTS: ..ottt e, 47.0%
TOtal. .o 100.0%
DANGER

See Precautionary Statements for additional information.

FIRST AID
If on skin or e Take off contaminated clothing.
clothing e Rinse skin immediately with plenty of water for15-20 minutes.
e Call a poison control center or doctor for treatment advice.
If swallowed e Call poison control center or doctor immediately for treatment advice.
e Have person drink several glasses of water.
¢ Do not induce vomiting.
e Do not give anything by mouth to an unconscious person.
If in eyes e Hold eye open and rinse slowly and gently with water for 15-20
minutes.
e Remove contact lenses, if present, after the first 5 minutes, then continue
rinsing eye.
e Call a poison control center or doctor for treatment advice.
HOT LINE NUMBER
Note to Physician | Probable mucosal damage may contraindicate the use of gastric lavage.
Have the product container or label with you when calling a poison control center or doctor, or
going for treatment. For further information call National Pesticide Telecommunications
Network (NPTN) at 1-800-858-7378.

Net Contents: Two anti-foulant devices

Sea-Bird Electronics, Inc. EPA Registration No. 74489-1
1808 - 136™ Place Northeast EPA Establishment No. 74489-WA-1
Bellevue, WA 98005
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PRECAUTIONARY STATEMENTS
HAZARD TO HUMANS AND DOMESTIC ANIMALS
DANGER
Corrosive - Causes irreversible eye damage and skin burns. Harmful if swallowed. Harmful if
absorbed through the skin or inhaled. Prolonged or frequently repeated contact may cause allergic

reactions in some individuals. Wash thoroughly with soap and water after handling.

PERSONAL PROTECTIVE EQUIPMENT

USER SAFETY RECOMMENDATIONS

Users should:

e Remove clothing immediately if pesticide gets inside. Then wash thoroughly and put on
clean clothing.

e Wear protective gloves (rubber or latex), goggles or other eye protection, and clothing to
minimize contact.

e Follow manufacturer’s instructions for cleaning and maintaining PPE. If no such instructions
for washables, use detergent and hot water. Keep and wash PPE separately from other
laundry.

e Wash hands with soap and water before eating, drinking, chewing gum, using tobacco or
using the toilet.

ENVIRONMENTAL HAZARDS

Do not discharge effluent containing this product into lakes, streams, ponds, estuaries, oceans, or other
waters unless in accordance with the requirements of a National Pollutant Discharge Elimination
System (NPDES) permit and the permitting authority has been notified in writing prior to discharge.
Do not discharge effluent containing this product to sewer systems without previously notifying the
local sewage treatment plant authority. For guidance contact your State Water Board or Regional
Office of EPA. This material is toxic to fish. Do not contaminate water when cleaning equipment or
disposing of equipment washwaters.

PHYSICAL OR CHEMICAL HAZARDS
Do not use or store near heat or open flame. Avoid contact with acids and oxidizers.

DIRECTIONS FOR USE

It is a violation of Federal Law to use this product in a manner inconsistent with its labeling. For use
only in Sea-Bird Electronics’ conductivity sensors. Read installation instructions in the applicable
Conductivity Instrument Manual.
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STORAGE AND DISPOSAL

PESTICIDE STORAGE: Store in original container in a cool, dry place. Prevent exposure to
heat or flame. Do not store near acids or oxidizers. Keep container tightly closed.

PESTICIDE SPILL PROCEDURE: In case of a spill, absorb spills with absorbent material. Put
saturated absorbent material to a labeled container for treatment or disposal.

PESTICIDE DISPOSAL: Pesticide that cannot be used according to label instructions must be
disposed of according to Federal or approved State procedures under Subtitle C of the Resource
Conservation and Recovery Act.

CONTAINER DISPOSAL: Dispose of in a sanitary landfill or by other approved State and
Local procedures.

Sea-Bird Electronics/label revised 01-31-05

86




Appendix VI: Wave Theory and Statistics

Appendix VI: Wave Theory and Statistics

Surface Gravity Waves - Description

Types of Waves and Restoring Forces

The most characteristic physical feature of any kind of wave is the restoring
force. If a medium at rest (such as still water) is disturbed in some way (by the
wind, for example, or by dropping a rock into a pond), the restoring force acts
to return the medium to its initial still state.

Compressibility is the restoring force for sound waves. Surface tension acts as
the restoring force at any surface of contact between any two different fluids
(like air and water), and produces very high frequency capillary waves.
Gravity waves arise through the restoring force of gravity on water particles
displaced from equilibrium levels. If the equilibrium level is a free surface (the
boundary between water and air), surface gravity waves are formed. If the
equilibrium level is an internal surface in a stratified fluid, internal gravity
waves are formed. These internal waves tend to have longer periods (minutes
to hours) than surface gravity waves (seconds). Finally, planetary effects such
as rotation introduce restoring effects such as the Coriolis force and potential
vorticity, yielding very long period waves called inertial waves, Rossby, and
planetary waves.

Spectrum of Surface Waves in the Ocean

Surface waves in the ocean occupy a broad range of wavelengths and periods.

e At extremely short periods, the spectrum is dominated by capillary waves,
followed by a broad (1 - 20 second) band of surface gravity waves, mostly
wind driven.

e Longer period (> 10 minutes) gravity waves may occur in association with
earthquakes and large-scale meteorological systems (storm surges).

e Tides, which are another type of forced gravity wave, dominate the
spectrum in the 12 - 36 hour band.

e At longer periods, inertial and planetary waves are prevalent; gravity does
not play a dominant role any longer.

See Pond and Picard (Figure 12.1, Table 12.1) (Appendix VIII: References).
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Definition of Terms

a = wave amplitude, [m]

D, = density of water, [Kg/m?3]

E =W_H?/8, total wave energy per unit area, [J/m?]

f =1/T, wave frequency, [Hz], [cycles/sec]

g = 9.80665, acceleration of gravity, [m/sec?]

h = water depth, [m]

H = 2a, wave height, [m]

k =2 n/ L, wave number, [rad/m]

L = wave length, [m]

0] = phase angle, [radians]

o =2 nn/ T, radian frequency, [rad/sec]

t = time, [sec]

T = wave period, [sec]

T, = total time of the wave burst series (total sample period), [sec]
W, =D, g, specific weight of water, [Kg/(m?sec?] = [Pa/m]
X = horizontal distance, [m]

Z = instrument depth, [m]

Basic Linear Wave Description

A traveling disturbance of the sea surface is commonly represented as a linear
simple harmonic wave traveling in the x horizontal direction:

A (x,t) = a cos (kx - ot + ) (1]

A
-
y

Crest

T

Mean water level

| T

A

Trough

Seafloor

Simple-Harmonic Linear Wave Traveling on the Sea Surface
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Phase Angle

The phase angle ¢ represents a shift of the wave relative to some reference
time. This is useful for describing the relationships between a group of waves
of different frequencies. When a time series is separated by spectral analysis
methods into frequency components defined by [1], the two numbers that are
computed for each frequency are:

amplitude a(f)

phase o(f)

The physical time lag associated with a given phase depends on the wave
period (T). For example, a phase of & radians implies a time lag of 5 seconds
for a wave with a period of 10 seconds (T = 10 sec), while the same phase
implies a lag of 2.5 sec for a wave with T =5 sec.

Dispersion Equation

For surface gravity waves described by [1], there is a special relationship
between wave period and wave length. This relationship, which depends on
water depth, is called the dispersion relation and is given by:

6 2 = gk tanh (kh) [2]

Implications of Linear Theory

Equation [1] represents a single frequency-wavenumber component of a sea
surface that usually contains a whole group of waves of different sizes,
lengths, and propagation directions. One of the major assumptions of linear
theory is that we can take this jumbled combination and treat each frequency
component (or frequency band) separately by using [1].

First order linear small amplitude theory is the simplest and most direct
solution to a very complex general set of equations and boundary conditions
for surface gravity waves. The simple results are based on a set of
approximations that are strictly valid only over a restricted range of conditions.
Small amplitude wave theory is not a good model of steep or breaking waves,
or waves traveling in very shallow water. The theory is a good model of long
ocean waves away from viscous boundary layers and horizontal boundaries.
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Assumptions

For the linear theory to be valid, a major requirement is that the wave height H
be small compared with both the wavelength L and the water depth h. These
conditions are usually expressed as:

H/L <<1 (wave steepness)

HL?/h3 <<1 (Ursell parameter)

Another measure of the effect of wave steepness on the validity of the small
amplitude theory, based on laboratory measurements, is shown below. For the
theory to be valid, you must be below the curve indicated. For example, if the
wave period of interest T is 10 sec and the water depth h is 100 meters, the

parameter h / gT? = 0.1. This means that H / gT* must be less than 0.001 for
the theory to be valid, which translates into a maximum wave height of
1 meter.

0.01

0005 |
H/gT? —

0.002

0.001

0.0005

0.0002

0.0001

0.00005 |1 | L 11 |1 [ 11l
00005  0.001  0.002 0005 001 002 005 0.1 02

h/gT?

Range of Validity of Linear Wave Theory
(Theory Valid for Values Below Curve)

A final rule of thumb is that estimates of surface wave heights should be
accurate within £+ 5% provided:

z/L<0.3100.5,

where z is the depth of the instrument below the surface and L is the
wavelength of the observed waves.
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Subsurface Pressure Due to Surface Gravity Waves

As a surface wave passes over a subsurface position, the elevation and
depression of the sea surface causes a differential subsurface pressure

disturbance. This pressure disturbance decays with depth according to
the relation:

pP=WwA@®K(fz) [Pa] (3]
where the vertical pressure response function is:
K (f,z) = cosh [k (h - )] / cosh (kh) [dimensionless] [4]

where

A(t) (defined by [1]) = water surface displacement, which varies between +a
and -a meters

W = specific weight of water near the surface

h = water depth

k = wave number [radians/m], calculated for a given wave period and depth
with the dispersion relation [2]

z = vertical distance [m] from the measurement point to the mean
(undisturbed) water surface

Equation [3] is the essential result required to relate subsurface pressure to
surface wave height. For a given pressure frequency component P(f), the
transfer function used to obtain surface wave amplitude a(f) from subsurface
pressure is:

a((=P{H/WyK(fz)  [m] (3]

For deep water waves (kh >> 1 and h/L > 0.5) equation [3] takes the form:
p=WyAe™  [Pa] [6]

which clearly represents an exponential decay with depth.

For shallow water waves (hk << 1 and h > L/2) equation [3] takes the form:
p= WyA  [Pq] [7]

which is simply the hydrostatic equation.
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The table below, developed with Plan Deployment, shows pressure attenuation
[p(bottom) / p(surface)] vs. bottom depth for waves with T =2, 5, 10, 20, and

25 seconds.
Water | Sensor Height Wave Period [seconds]
Depth | above Bottom
[meters] [meters] 25 20 10 5 2
2 0 0.99 0.99 0.96 0.84 0.25
4 0 0.99 0.98 0.92 0.70 0.04
8 0 0.97 0.96 0.84 045 | -
15 0 0.95 0.93 0.72 017 | -
20 0 0.94 0.90 0.63 0.08 | ----
30 0 0.91 0.85 0.48 002 | -
40 0 0.87 0.81 035 | - | -
50 0 0.84 0.76 025 | - | -
75 0 0.77 0.65 01 | - | -
100 0 0.70 0.55 004 | - | -
Pressure attenuation [p(bottom) / p(surface)] for various bottom depths
and wave periods (----- = less than 0.001).

High Frequency Cutoff

The table above shows that the pressure attenuation with depth is a strong
function of the wave period; short period waves attenuate much faster with
depth than longer period waves. This implies that for a pressure sensor
deployed at a fixed depth z, there is a high frequency cutoff fmax for which
waves with f> fmax are not measurable. Above the high frequency cutoff, any
noise in the subsurface pressure record is mapped by the transfer function into
unrealistic surface wave height values. The default high frequency cutoff for

Process Wave Burst Data is the frequency where the ratio of pressure
Note: measured by the SBE 26 to pressure at the surface is less than
Frequencies greater than fmax (0.0025 / wave sample interval) [see equation 20]. Frequencies greater than

are processed if Use filter fmax are not processed by Process Wave Burst Data for most applications.
cutoff is selected in Process

Wave Burst Data.

Example:

Water depth is 10 meters. You are interested in measuring waves with
frequencies up to 0.36 Hz (period =1/ 0.36 = 2.8 seconds). You plan to
sample waves 4 times per second (wave sample interval = 0.25 seconds)
with 1024 samples per wave burst, and to process data with 10 spectral
estimates/band. Can you place the SBE 26 at 1 meter above the bottom and
accomplish your goals?

Running Plan Deployment with the above parameters, the Frequency Span is
0.0215 to 0.3340 Hz. Since 0.334 < 0.37, you cannot accomplish your goals.

Iterating on a solution by changing the instrument height in Plan Deployment,
you find that placing the SBE 26 at 2.5 meters above bottom will allow you to
measure the desired frequencies. Alternatively, you could consider modifying
other sampling parameters while maintaining the instrument height.
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Wave Processing Steps

To compute surface wave energy spectra and statistics, the frequency
dependent attenuation must first be removed from the subsurface pressure
data. Fourier analysis techniques are used to decompose the subsurface time
series into a group of linear wave components, each with a distinct frequency,
amplitude, and phase.

Initial Processing of Pressure Data

First the wave burst data is read into an array. The mean is computed and then
the mean and trend are removed from the array. A trend is expected in the
wave data due to tides and other low frequency waves. If these trends are

not removed, distortions can occur in the processing of spectral estimates;

the ramp function in the time domain leaks all over the spectrum in the
frequency domain.

Density (D,, ) is computed from the user-supplied salinity and temperature.

Instrument depth (z) and water depth (h) are computed by:
z = 6894.757 ( mean pressure - 14.7)/Dw g [m] [8]
h = z + height of pressure sensor above bottom [m] [9]

where the factor 6894.757 is used to convert the pressure from psi to Pascals.

If the number of wave samples is not a power of two, the array length is
made a power of two by filling it with the last de-meaned and de-trended
pressure value.

Next, a Hanning window is applied to the time series to suppress the spectral
leakage that occurs when the time series to be Fourier transformed contains a
periodic signal that does not correspond to one of the exact frequencies of the
FFT. Physically, this means that an integral number of waves does not fit in
the time series. When this occurs, energy at one frequency leaks to other
frequencies. This causes errors when applying the frequency dependent
dispersion transfer function to the transformed data. The Hanning window has
the form:

u(t)=1-cos’(mt/Ty) 0<t<T, [10]

The windowing operation reduces the total energy in the time series so each
element is multiplied by the scale factor SF, where

SF= (8/3)" [11]

to obtain the correct magnitudes in later spectral estimates.

Finally, each element in the time series is multiplied by the factor 6894.757 to
convert the measured pressure from psi to Pascals.
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Surface Wave Auto-Spectrum

The Finite Fourier transform of a time series with N points contains N raw
spectral estimates at frequencies given by:

Fi=j|T, j=0,N-1 [Hz] [12]

where T is the total time of the series (seconds). The first spectral estimate

(j = 0) is the mean of the time series, and is 0 since the subsurface pressure
time series has been de-meaned.

The interval between spectral estimates (resolution bandwidth) is:
8f=1/Ty,=1/(Ndt) [13]

where 8t is the time interval between samples in the subsurface pressure
time series.

While N raw spectral estimates are computed, only the first (N/2 + 1) are
unique. For a real input time series the second (N/2 - 1) values are identical to
the first N/2 values. The limiting frequency is the Nyquist frequency, given by:

Nyquist=1/(26t) [Hz] [14]

The forward Fourier transform of the time series is defined by:
N-1

Zi=(1/N) Y xyexp(-i2nnj/N) [15]
n=0
where
Z; (the raw spectral estimates) are complex numbers.

i=(-1)"”
The raw spectral estimates are directly related to the single frequency wave
described in [1]:

4= 27|, ¢j=arg(Z;) [16]

The variance at each frequency is:

var,= | Z|* , j=1,N-1 [17]

The total variance of the spectrum:
N-1
vargm= 2. |Zi|* [Pal] [18]
j=1
is equal to the variance calculated from the time series [28].
For each frequency up to the Nyquist, the relationship between the single

pressure wave variance [1] and [17] is:

aj>/2=2var; [19]
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Once the Fourier transform has been obtained, the Fourier coefficients for the
frequencies greater than fmax and less than fmin are typically set to 0.0:

fmax = minimum of:

frequency where ( subsurface / surface pressure = 0.0025 /3 t) [20]
or

1 /user input minimum period [21]

fmin = 1 / user input maximum period [22]

Maximum frequency limits prevent noise in the subsurface time series from
being mapped by the dispersion transfer function into unrealistic wave heights.

If the user selected Use filter cutoff, a filter is applied that ramps the Fourier
coefficients down to 0 for frequencies greater than fmax and less than fmin.
e  For frequencies less than fmin:
fourier coefficient = f * exp ([f — fmin]/ fc)
e For frequencies greater than fmax:
fourier coefficient = f * exp ([fmax — f]/ fc)
where
f = frequency
fc = user input filter value

A copy of the Fourier transform is saved; it will be used to recover the surface
wave time series.

Band Averaging

Each raw spectral estimate contains two degrees of freedom. Band averaging
can be used to increase the number of degrees of freedom and reduce the error
of the estimate. The number of degrees of freedom (n ;) associated with
grouping n ; spectral estimates in a frequency band of width df is twice the

number of frequencies in the band. 6f=n /T,

Band averaging is performed by adding up the total variance in a frequency
band and dividing the sum by the width (Hz) of the frequency band (5f). For
positive frequencies less than the Nyquist, the estimate of the one-sided
subsurface pressure auto-spectral density function for a frequency band
centered at f, is:

ne
2 ) 1Z|?

k=1
of

<G, (fy)>= [Pa’® sec] [23]

Confidence Intervals (Error Bars)

The properties of a real-world (random) time series cannot be precisely
determined from sample data. Only estimates of the parameters of interest can
be obtained. The method for setting error bars on the estimates of the auto-
spectral density function <Gpp> is related to the Chi-Square distribution

function: X2.

95



Appendix VI: Wave Theory and Statistics

The confidence interval (1-co;; o is the significance) for the true auto-spectral
value G based on an estimate <G_ > is given by:

n4<Gp> n4<Gp>
—— =G,({fy)= [24]
XZnga/2 XZngl-a/2
where

n, = 2 * number of frequency bands averaged

X?n ;o = percentage points, Chi-Square distribution with n degrees of

freedom and significance o

The Chi-Square distribution is described completely in most statistics books
(for example, J. E. Freund, Mathematical Statistics, 1962, Prentice Hall, Inc.).
For example, if 10 frequencies are averaged per band and we wish to know the
error bars corresponding to the 90% confidence interval:

n, =20 alpha = significance = 0.1

Xz =31.41 X2 =10.85

20;0.05 20;0.95
Therefore, the error bar is:

(0.637 <G ,,>) <G, < (1.843 <G, >)

This means that we can say with 90% certainty that the true value of G, lies
somewhere between 0.637 and 1.843 times the estimated value of Gpp.

When band averaging, the value of the auto-spectral estimate lies somewhere
in the band averaged frequency band; the error bars for the frequency are as
wide as the band.

Band averaging is a trade-off between vertical and horizontal error bars. If you
average a lot of bands, you get a good estimate of the magnitude of a peak in
Gpp, but there is a lot of uncertainty as to its precise frequency value. If you
band-average only a few bands, the frequency of a peak is precisely defined,
but there is a lot of uncertainty as to the value of G ..

Sometimes a peak in the spectrum stands out from the background if there are
few frequencies in the band, but vanishes into the background as the number
of frequencies averaged increases. When this happens, an understanding of the
physical problem being investigated can help in deciding whether the peak is
real or not.

Surface Wave Auto-Spectral Density Function

The one-sided surface wave auto-spectral density function for a frequency
band centered at f is:

Gu (f5)=|H () [ Gpp (fp)  [m” sec] [25]

The transfer function H (f,) is used to convert the subsurface pressure to
surface waves and is computed with equations [2] and [4].

H(fy)=1/[W.K(f,z)] [m/Pa] [26]
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A plot of the surface wave auto-spectral density function G, with error bars is

probably the most useful way of describing the sea surface shape due to a
surface wave field. A glance at the spectrum shows where the wave variance is
in frequency space.

The surface wave spectral density function G,, has units of [m? sec]. To find

the variance [m?] in a frequency interval 8f (Hz), multiply G__ by &f.

Total Variance and Energy

The total variance Var,; is the sum of all the band-averaged spectral estimates:

Ny

var = 2. Ga(f)df  [m? [27]
k=1

where
6f is the number of spectral estimates in the band divided by the total sample

period,
n, is the number of frequency bands computed,

G,,(f,) is the spectral estimate for the frequency centered at f,.

The total wave energy (J / m?) is found by multiplying the total variance by
the specific weight of water (W ).

Significant Wave Height and Period
The significant wave height is the average height of the highest 1/3 of the
waves and is estimated from the auto-spectrum as:

Hiys= 4 (Varg)"” [m] [28]

The significant wave period estimated from the auto-spectrum is the period
corresponding to the frequency with the highest variance.

Surface Wave Time Series

To reconstruct the surface wave time series from the subsurface pressure, the
transfer function H(f,) [see equation 26] is applied frequency by frequency to

the scaled raw spectral estimates:

A(f)=H(fi)P(fi))  fi<Nyquist [29]

where A(f)) are the raw spectral estimates of surface wave amplitude and P(f))
are the spectral estimates of subsurface pressure. The spectral estimates for

f, > Nyquist are given by A(F__,) = A(f).
The Inverse Fast Fourier Transform (IFFT) is taken to construct the surface

time series.

97



Appendix VI: Wave Theory and Statistics

The influence of the Hanning window is removed with a deconvolution in the
time domain; each point x; is multiplied by the inverse of the Hanning window

w; corresponding to the same time point. This procedure is unstable near the
end points where w;, = 0. Therefore, the time series is set to 0 at the beginning
and end where the window reaches 1% of its maximum value.

Finally, each point in the time series is multiplied by 1 / sqrt (8/3) to
compensate for the initial scaling of the time series.

Total Variance and Energy

The unbiased sample variance is a fundamental statistical measure of the time
series. Variances from different bursts can be compared to see if the wave field
is stationary or changing. The unbiased estimator for the variance is:

N-1

<o, >=(1/[N-1]) X |xj-<p>|? [m] [30]
=0

where p, is the sample mean. In this case, the mean is zero since the time
series has been de-meaned. The variance obtained from the reconstructed time
series can be compared with the total variance obtained from the auto-
spectrum [25] as a check on the goodness of the time series reconstruction.

An estimate of the total wave energy contained in the record is:

E=W, <o, > [J/m?] [31]

Average Wave Height and Period: H,,, T,

Since the wave time series is typically very irregular due to the random nature
of the sea surface, the calculation of wave heights and periods can only be
approximate and statistical. A standard method for estimating wave heights
and wave periods is summarized in the Handbook on Wave Analysis and
Forecasting, from the World Meteorological Organization (WMO- No. 446,
1976, Geneva, Switzerland) and illustrated below:

T, T, T3 Ty

\/'\ L

Zero-Crossing Method for Estimating Wave Heights and Periods
from a Wave Time Series

Individual waves are isolated by identifying the zero upcrossings; H and T for
each captured wave is stored in an array. Averaging over all the captured

waves yields the average wave height H,,, (meters) and the average period

Toe (seconds). H, . is the largest captured wave.
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Sea State (Significant Wave Height)

The significant wave height (H, ;) and average period (Tavg) define the sea
state. H, ; is the average height of the highest 1/3 of the waves and has

physical significance because it is the approximate wave height picked out
visually and reported by trained observers at sea.

T, is obtained by picking out the highest 1/3 of the captured waves and
averaging their periods.

The parameters H, ,, and H, ,, are similarly defined as the average height of
the highest 10 and 1 percent of the captured waves, respectively.
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Appendix VII:
Pressure-to-Depth Conversion

Force is mass * acceleration, units are newtons [N]:

N=Kgm/sec’

Density (p) is mass / volume, units are [Kg/m*]:
This is the in situ value, and is approximately 1025 Kg/m*
at the surface.

Specific weight (W) is weight / volume, units are [N/m*]:
W=p*g

where g = local gravity [m / sec *]

Hydrostatic equation:
P=Pum+ W *2z
Paum = atmospheric pressure in Pascals [N/ m?]
p = total pressure in Pascals [N/m?]
W is average density times gravity [N/m°]

z = depth [m]

Conversions:
1 Pascal = 10™ decibars

1 psi = 0.6894757 decibars

Example:
average density = 1025 kg / m*
average gravity = 9.8 m/ sec’
pressure reading = 6000 decibars = 6 x 10 ’ Pascals
atmospheric pressure = 14.7 psia = 1.013529 x 10 ° Pascals
W =1025*9.8=10045 [N/m"]
6x107-1.013529 x 10°= 10045 * z

z=5.989865 x 10 "/ 10045 = 5963.031 meters
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hex-head, titanium

optional titanium housing

Part — _— Quantity
Number Part Application Description in 26
Battery, alkaline
22018 |D-cell, Duracell Power SBE 26 9
MN1300 (LR20)
41124 |Battery cover plate  |Retains alkaline batteries 1
9D (10.8 V/42 amp-
801483 |hours) lithium battery |Note: Batteries not included. -
pack kit
30346 Screw, 10-24 x 1 Secures connector end cap to 4

SBE 16/19

50092 Jackscrew Kit

For removing connector end cap

Spare battery end

60021 | o arts

Assorted o-rings and hardware:

¢ 30090, Parker, 2-153N674-70
(housing face seal)

e 30145, Mach Screw, 6-32 x %2 PH
SS (secures battery retainer plate to
bulkhead posts)

e 30242, Washer, #6 Flat, SS (for
30145 screws)

® 30816, Parker, 2-234E603-70
(battery end cap piston seal)

50056 |Spare parts kit

Assorted spare parts:

® 30090, Parker, 2-153N674-70 (face
seal, battery end cap)

e 30815, Parker, 2-233E603-70
(piston seal, connector end cap)

¢ 30816, Parker, 2-234E603-70
(piston seal, battery end cap)

e 30145, Mach screw, 6-32 x Y2 PH
SS (battery endplate)

e 30242, Washer, #6, Flat SS (for
30145 screws)

e 30447, Bolt, -20 x 1-1/4 Hex
(end cap lift eye hardware)

e 30493, Mach screw, 10-24 x 1-1/4
(secures connector end cap to
plastic housing)

® 30552, Retaining ring (secures
mounting fixture to its bolt)

Continued on next page
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Continued from previous page

mooring lock pin

Part " _— Quantity
Number Part Application Description in 26
3-pin to 3-pin cable, From SBE 26 to optional
17695 |RMG-3FSto conductivity sensor - standard 1
RMG-3FS, connectors !
0.28 m (11 in.) long
3-pin to 3-pin cable, |From SBE 26 to optional
171752 MCIL-3FS to conductivity sensor - optional 1
RMG-3FS, wet-pluggable connector on
0.28 m (11 in.) long |SBE 26
4-pin RMG-4FS
801225 to DB-9S From SBE 26 to computer - 1
data I/O cable, standard connector
2.4 m (8 ft) long
4-pin MCIL-4FS
801374 to DB-9S From SBE 26 to computer - 1
data I/O cable, optional wet-pluggable connector
2.4 m (8 ft) long
25-pin DB-25S to . .
171888 |9-pin DB-9P cable For use with computer with 1
DB-25 connector
adapter
17043 |Locking sleeve Locks I/O cable or dummy plug )
in place - standard connector
Locks I/O cable or dummy plug
171192 |Locking sleeve in place - optional wet-pluggable 2
connector
3-pin RMG-3FS For when optional conductivity
17045.1 |dummy plug with sensor not used - standard 1
locking sleeve connector
3-pin MCDC-3-F For when optional conductivity
171500.1|dummy plug with sensor not used - optional wet- 1
locking sleeve pluggable connector on SBE 26
4-pin RMG-4FS For 1/O connector during
17046.1 |dummy plug with 1
. deployment — standard connector
locking sleeve
4-pin MCDC-4-F For I/O connector during
171398.1|dummy plug with deployment - optional wet- 1
locking sleeve pluggable connector
For use with optional
801347 / |AF24173 E?n((gli%mt”%;;nioiz_ dovi 1
801542 |Anti-Foulant Device |, 0 oY oxide device (set of 2)
inserted into anti-foulant
device cup in mount kit
. . Mounts on ends of conductivity
50315 |Anti-foulantdevice o1y hold AF24173 Anti- 1
mount kit .
Foulant Devices
Octyl Phenol Ethoxylate —
Reagant grade non-ionic cleaning
30411 |Triton X-100 solution for conductivity cell 1
(supplied in 100% strength;
dilute as directed)
50102 |Mounting fixture Optional mounting fixture with |
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